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13 EVENT RECORDER

INTRODUCTION

SAFETY REQUIREMENTS

General Rules
To prevent physical injury or damage to equipment, all personnel directly or indirectly involved in the maintenance
of the 5000 Series rapid transit cars must observe the following:

(1)
()

©)

(4)

(%)

Observe all Chicago Transit Authority (CTA) safety rules and regulations.

Follow all WARNINGS, CAUTIONS, and NOTES found throughout this manual (see below). If you must use
a work procedure or tool that is not covered in this manual, you must select a method that is safe and will
not damage equipment.

Follow the recommended preventive maintenance schedule and procedures provided in this manual.
Failure to perform maintenance tasks in accordance with the recommended maintenance schedule may
result in equipment failure.

Ensure that maintenance tasks are performed by qualified personnel with the appropriate job skill levels and
training. Improper performance of maintenance tasks may result in equipment failure or personal injury.

When performing maintenance tasks, use the appropriate personal protective equipment (PPE) in
accordance with CTA regulations.

Where conventional tools are not adequate for a particular task, use the special tools or test equipment
identified in this manual.

Use replacement parts that are identical to the original equipment. Refer to the List of Supplies provided in
the maintenance manuals. The use of non-approved substitute parts may result in equipment damage or
malfunction or personal injury.

Where fasteners removed from car equipment are not satisfactory for reuse, be sure to select replacements
that match the originals. Mismatched or incorrect fasteners can result in equipment damage or malfunction
or personal injury.

The information in this section is provided by the carbuilder for technical information purposes only. If this
information conflicts with established CTA procedures, CTA procedures shall govern.

076MM201508 13-1
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Warnings, Cautions, and Notes
The procedures in this manual may contain warnings, cautions, or notes. These are defined as follows:

WARNING

Identifies an instruction, which, if not followed, could cause
serious personal injuries including the possibility of death.

CAUTION

Denotes an instruction, which, if not followed, could severely
damage vehicle components.

NOTE

@ b O

Indicates supplementary information needed to fully
complete an instruction.

As required by the maintenance or operational situation, take particular note of the following:

WARNING

When making up consists, make sure all personnel are clear
of cars prior to movement. Follow all safety instructions.
Failure to do so may result in damage to property, serious
injury, or loss of life.

WARNING

For the protection of personnel around or under the consist,
ensure that the wheels are chocked. For made-up trains,
ensure that the car crew is aware of personnel movement.
Failure to do so may result in damage to property, serious
injury, or loss of life.

13-2 076MM201508
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WARNING

Dangerous voltages are present throughout the consist.
Exercise extreme care when working on or near electrically
charged equipment. Observe all CTA safety rules and
procedures. Failure to do so may result in damage to
property, serious injury, or loss of life.

WARNING

Before making any power jumper connection, verify that
power has been cut off in the cars or at the shop/wayside
supply. Handle all jumpers with care and in accordance with
CTA operating rules and instructions. Failure to do so may
result in damage to property, injury, or loss of life.

WARNING

When checking continuity or when handling equipment
connections, shut off car power. Failure to do so may result
in damage to property, injury, or loss of life.

WARNING

Isolating a single car from others in the train does not ensure
that equipment is safe. Instead, make sure the entire train is
isolated from the electrical power supply and batteries are
disconnected.

076MM201508 13-3
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WARNING

Before disassembling any electrical unit, removing any
electric board, or unplugging any connectors, ensure that the
unit is isolated from its electrical power source. Failure to do
so may result in damage to equipment, serious personal
injury, or loss of life.

WARNING

When working on equipment containing capacitors, be aware
that these devices can retain lethal voltages even after being
isolated from the high voltage supply. Check capacitors with
a voltage multimeter to ensure they have discharged to a safe
level (less than 10V).

WARNING

Make sure that equipment cannot be started automatically or
accidentally. If valves are closed or circuits interrupted
during service procedures, control switches must be suitably
tagged. Failure to do so may result in damage to property,
serious injury, or loss of life.

WARNING

Unless absolutely necessary, do not perform maintenance
under a car while the hydraulic suspension system is active.
Instead, secure the carbody using standard CTA procedures
then de-energize and depressurize the hydraulic suspension
system (dead mode). Failure to do so may result in damage to
equipment, serious injury, or loss of life.

076MM201508
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WARNING

If you must perform work on the car while the hydraulic
suspension system is active, be aware that the carbody may
raise or lower unexpectedly. Keep clear of pinch points under
the vehicle. Failure to do so may result in serious injury or
loss of life.

WARNING

Equipment requiring removal must be isolated from the
pressurized hydraulic system. Ensure that pressure is
released before working with any hydraulic fitting, hose, or
component. Failure to do so may result in serious injury or
loss of life.

WARNING

Hydraulic fluid is under high pressure and temperature and
can penetrate or burn skin. Follow approved maintenance
procedures when replacing hydraulic components. Failure to
do so may result in serious injury or loss of life.

WARNING

When working with dangerous materials, make sure the area
is well-ventilated and avoid prolonged breathing of vapors.
Avoid contact with skin. Keep materials away from flame.
Consult the appropriate material safety data sheet for safe
handling procedures. Wear the appropriate Personal
Protective Equipment (PPE) and clothing. Failure to do so
may result in damage to property, serious injury, or loss of
life.
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WARNING

Following operation, some equipment surfaces may be hot
enough to burn skin. Allow sufficient time for surfaces to cool
before working on or around equipment. Failure to do so may
result in injury.

WARNING

When removing or installing heavy components, use the
appropriate lifting equipment and techniques. Be aware that
the center of gravity of the component may be offset. If
necessary, enlist the help of additional personnel. Failure to
do so may result in damage to equipment, serious injury, or
loss of life.

WARNING

Oily or greasy surfaces may make components difficult to
handle. Exercise caution during component disassembly or
removal. Failure to do so may result in damage to equipment
or personal injury.

CAUTION

When replacing electrical equipment, make sure all electrical
connections are securely attached. Loose or damaged
electrical connections may result in intermittent equipment
operation or potential equipment damage (arcing).
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CAUTION

This device is an Electrostatic Discharge (ESD) sensitive
device. Damage may occur if device is subjected to high
energy electrostatic discharge. Ensure proper ESD
precautions and handling procedures are followed when
performing maintenance to avoid performance degradation
or loss of functionality of device.

CAUTION

Ensure that all hydraulic connections are properly secured
after maintenance. Leakage of hydraulic fluid on hot parts
creates a possible source of ignition. Loose or damaged
hydraulic connections may result in impaired system
performance, contamination, or failure.

CAUTION

Ensure that software versions installed on replacement
equipment are consistent with the operational configuration
of the car. Failure to do so may result in equipment
malfunction.

NOTE

When torquing fasteners, make sure to apply Torque-Seal.
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Abbreviation Definition
A Ampere
ATC Automatic Train Control
ATCU Automatic Train Control Unit
ADU Aspect Display Unit
BAS Bypass Activation Switch
BSC Bach-Simpson Corporation
BTE Bench Test Equipment
CHMM Crash-hardened Memory Module
CMN Car Monitoring Network
COTS Commercial Off-The-Shelf
CTA Chicago Transit Authority
DC Direct Current
eg. Exempli gratia (Latin, meaning "for example")
ER1 Emergency Relay 1
ERM Event Recorder Manager (ERU PTU software)
ERU Event Recorder Unit
F Fahrenheit
FTP File Transfer Protocol
ft-lb foot-pound
HTTP Hypertext Transfer Protocol
ID Identification
ie. id est (Latin, meaning "that is to say")
in. Inch
b Pound
LED Light Emitting Diode
LSI Low Speed Interlock
MB Megabyte
MC Master Controller
MCU Master Controller Unit
n/a Not Applicable
NOVRAM Non-volatile Random Access Memory
PCB Printed Circuit Board
PCN Propulsion Control Network
PTU Portable Test Unit
RTC Real-Time Clock
SBC Single Board Computer
SCI Software Configurable Item
sec second
STEM Side Trip Emergency
TCP/IP Transmission Control Protocol / Internet Protocol
TCMS Train Control and Management System
TOTS Train Operator’s Touch Screen
T™W Train Wire
13-8 076MM201508
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Abbreviation Definition
UTC Universal Time Coordinate
\% Volts
Vdc Volts, Direct Current
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GENERAL

Event Recorder System

The Event Recorder System for the 5000 Series cars is composed of a single component: the Event
Recorder Unit (ERU) which interfaces with the Train Control and Management System (TCMS). The TCMS
provides all its inputs which the ERU records on a Crash-hardened Memory Module (CMM).

The only way to retrieve the recorded data on the ERU is through the use of the ERU Portable Test Unit
(PTU).

THEORY OF OPERATION

Event Recorder Unit (ERU)

The ERU monitors analog, frequency, digital, and communication parameters through the Train Control and
Management System (TCMS) and stores that information in a crash-hardened memory module. This
information is then available for download and analysis using specialized software.

The ERU has a removable front cover to access its internal components during off-car servicing. The front
cover (see Figure 13-1 "Event Recorder Unit Architecture") has the following main components and
features:

* Network signal cable connectors: Ethernet 1 and Ethernet 2, each with green LINK and yellow
ACTIVITY LEDs

» Test Port plug and cap - to connect to Bench Test Equipment (BTE) or Portable Test Unit (PTU).
« Event Recorder Unit power plug connector
» Car identification (ID) plug connector
* Green POWER on Light-emitting Diode (LED)
* Red FAULT status LED
+ Ground screw.
The power and car ID connectors are unique and cannot be accidentally interchanged.

In operating conditions, green POWER LED should be illuminated (steady on) and FAULT LED should flash
every six seconds. This indicates that the ERU is powered up and running normally with no fault conditions.
If the FAULT LED is steady on, it means that there is a fault condition (refer to Troubleshooting section). The
ACTIVITY LEDs flash when the ERU receives or transmits information and the LINK LEDs are steady on
under normal conditions.

13.3.1.1 ERU Internal Description

13-10

The ERU is a modular assembly physically tied together by socket connectors. Major components are
shown in Figure 13-3 "ERU, Internal Components", and further described below. ERU architecture is
shown in Figure 13-1 "Event Recorder Unit Architecture".

The major internal components are:
*  Crash-hardened Memory module

The Crash-hardened Memory Module is a small steel box bolted to the left side of the ERU
housing. The memory module is insulated and sealed against heat, shock, and impact
damage, and has only one cable leading from it to the processor module. The memory module
stores data in a circular buffer using "flash" technology and does not require any power to
maintain its status. This memory card is only addressed by the Single Board Computer (SBC)
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Figure 13-1 Event Recorder Unit Architecture

that controls the data reading, writing, and verification processes. This allows individual
read/write access to the non-volatile memory devices in the memory module by the processor
module.

The processor module validates proper memory module operation - by means of ‘write with
read-back’ validation of data sent to the memory module. Unique indexes and check
sequences are embedded into each data block sent for recording to the memory module to
allow data block integrity validation during recorded data downloading.

Data stored on the memory module can be accessed and downloaded through the Ethernet
Test Port on the front cover. Data is not erased when downloaded. It is impossible for the train
operator to erase stored data.

» Single Board Computer Printed Circuit Board (PCB) assembly

The single board computer, using a Linux operating system, is responsible for the following
activities:

*  Monitoring channel data sources for event activity

* Recording event occurrences along with a date/time stamp to memory

* Providing access to stored data for downloading over the PTU port on demand

» Providing access to current data state information for operational verification on demand
»  Providing internal fault status and diagnostics information on demand.

The heart of the single board computer module is an EP9302 microprocessor running event
recorder application code located in the on-board flash memory device. This processor
controls the other system modules to carry out required functions of the ERU. The event
recorder application is maintained using a PTU through the test port on the front of the ERU.
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Figure 13-2 ERU, External Components
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Figure 13-3 ERU, Internal Components
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The 10/100 Base-TX Ethernet port on the single board computer supports PTU function
including data downloading, diagnostics, and code uploading. Interfaces use industry
standard protocols such as Hypertext Transfer Protocol (HTTP) and File Transfer Protocol
(FTP) over a communication layer identified as Transmission Control Protocol / Internet
Protocol (TCP/IP).

Ethernet module PCB assembly

Two 10 Base-TX Ethernet modules provide the interface channels between ERU and TCMS.
These two full-duplex Ethernet ports support a wide range of different protocols. Signals from
the train are transmitted to the ERU through two Ethernet cables that plug into connectors on
the ERU front panel.

The various train network signals recorded by the ERU are managed through the
Communications Module. The car monitoring network is fully bi-directional.

Real-Time Clock PCB assembly
ID Plug Module

Car identification information (in the form of the car number) is provided to the ERU by a CAR
1D plug unique to each car. The plug is inserted into a connector on the front of the ERU, and
is permanently attached to the car. The plug is a dummy connector, and the interconnections
inside the cap provide the car number.

Power Supply Board.

The ERU contains an integral power supply module that converts raw supply voltage to levels
required for use by the ERU. The power supply is totally isolated from the chassis including
the communication and discrete signal inputs. Power is delivered by a dedicated power
supply cable to a plug / connector on the front of the ERU. The processor module monitors
the state of the train power supply using a signal provided by the power supply module.

13.3.1.2 Portable Test Unit (PTU)

The ERU PTU consists of a laptop computer equipped with the Event Recorder Unit Management
(ERM) software, which provides detailed internal diagnostics and system testing capabilities.

13-14

This laptop is connected to the ERU using an Ethernet cable connected to the Ethernet test port on
the ERU front cover.

The ERM program provides the following functions:

Checking ERU operation in real-time

Checking for any ERU faults

Downloading stored data from the memory module

Updating (re-flashing) event recorder Software Configurable Item (SCls)
Changing (coordinating) ERU clock time

Reviewing ERU maintenance log

Performing certain other maintenance, administrative, and reporting tasks.

Certain ERM functions are password protected to prevent tampering.

The bench test equipment / PTU allows detailed diagnostics and system testing. The PTU is used on
the train and the bench test equipment is used in the shop during overhaul.

076MM201508
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13.3.1.3 Signals Recorded by the ERU

The Event Recorder Unit for 5000 Series cars records the following signals from the Car Monitoring

Network (CMN):

Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
ERU Internal Time Not Applicable (N/A) Internal
Brake Hydraulic Pressure (HPCU) IBrkHydPress ACar | ACarPROP 0 to 1000: Pressure value in (psi)
(BPrsA) )
iERUInter1-A
IBrkHydPress BCar | BCarPROP
(BPrsB) )
iERUInter1-B
Car Mileage (Odometer) ICarMileage ACar ACARPROP 0 to 429,467,295
(MileA) iERUInter1-A (Increments of 25 feet, maximum
value equivalent to over
ICarMileage BCar BCarPROP 2,000,000 miles)
(MileB) iERUInter1-B
Motor Torque Command ITracTrqCmd ACar ACarPROP -20,000 to 20,000
Tractive Torque Command by the | (TQCmdA) iERUInter1-A (-2000 to 2000 Ib ft traction value)
propulsion system (summation of four
motors). ITracTrqCmd BCar BCarPROP
A negative value corresponds to a | (TqCmdB) iERUInter1-B
torque opposed to train displacement.
Motor Torque Applied ITracTrgAppl ACar ACarPROP -20,000 to 20,000
Tractive Torque Applied (summation of | (TqApA) iERUInter1-A (-2000 to 2000 Ib ft traction value)
four motors).
) ITracTrgAppl BCar BCarPROP
A negative value corresponds to a
torque opposed to train displacement. (TgApB) iERUInter1-B
Propulsion Speed Sensor IPbcuCarSpd ACar ACarPROP 0 to 1000 (0 to 100 mph)
This is the actual car speed calculated | (SpdSenA) iERUInter1-A
by the PBCU.
IPbcuCarSpd BCar BCarPROP
(SpdSenB) iERUInter1-B
Axle 1 Actual Propulsion Speed | ISpdPulseFreq ACar ACarPROP 0 to 10000
Pulse Frequency ) )
(SpdPulA) iERUInter1-A Speed frequency in Hz.
This is the actual speed provided by the
propulsion speed sensor in pulse per | ISpdPulseFreq BCar BCarPROP
second from B Car Axle # 1. .
(SpdPulB) iERUInter1-B

076MM201508

13-15



5000 Series Rapid Transit Cars

Table 13-1 CMN Input Signals to ERU
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CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
Motor Axle 1 — Wheel Diameter IAxleWheelDiam ACar ACarPROP 0: 28.00 in.
(PwhdA) iERUInter1-A 1:27.75in.
IAxleWheelDiam BCar BCarPROP 2:27.50 in.
(PWhdB) iERUInter1-B 3:27.25in.
4:27.00 in.
5:26.75in.
6: 26.50 in.
7:26.25in.
8:26.00 in.
9:25.75in.
10 to 19: Not valid
20: 28.25in.
21:28.50in
22 to 255: Not valid
Propulsion Mode IPropMode ACar ACarPROP 0: Coast
(PrModeA) iERUInter1-A 1: Brake
IPropMode BCar BCarPROP 2: Propulsion
(PrModeB) iERUInter1-B 3 10 255: Not valid
Track Brake Command ITrackBrkCmd ACar | ACarPROP 0: Command inactive
(TBCmdA) . .
iERUInter1-A 1: Command active
ITrackBrkCmd BCar | BCarPROP 210 255: Not valid
(TBCmdB) .
iERUInter1-B
Emergency Relay 1 (ER1) Status IEmergRelay1St ACar | ACarPROP 0: Emergency brake request
EmR1A
When the relay is de-energized, ( ) iERUInter1-A 1: No emergency brake request
emergency brake is requested. ) ) )
Train Wire 17 (TW-17) 2 to 255: Not valid
When the relay is energized,
emergency brake is not requested. IEmergRelay1St BCar | BCarPROP
(EmR1B) .
iERUInter1-B
Wheel Slip and Slide Control IWssSt ACar ACarPROP 0: No WSS
(WhsA) iERUInter1-A 1: WSS
IWssSt BCar BCarPROP 210 255: Not valid
(WhsB) iERUInter1-B

13-16
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Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
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CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

from IPTDir train  configuration
structure, retransmitted by the ATCU for
the ERU.

Abbreviation)
Outside Yellow Light Status I0utYellowLight ACar | ACarPROP 0: Light is Off
LtYelA
Outside hydraulic brake status yellow ( ) iERUInter1-A 1: Light is On
Light.
g (TW-13) 2 to 255: Not valid
I0utYellowLight BCar | BCarPROP
LtYelB
(LtvelB) iERUInter1-B
(TW-13)
Car Actual Speed ICarActualSpeed (AtcSpd) | ATCU 0 to 255: Speed in mph
Car Actual Speed provided by ATCU iERUInter2
0 to 75: normal speed range of vehicle.
76 to 255: abnormal speeds due to
wheel slip, or other
electrical/configuration fault.
Allowable Speed ICarAllowSpeed ATCU 0:
(AtcAlwSpd) )
iERUInter2 1: 15mph
2: 25mph
3: 35mph
4: 45mph
5: 55mph
6: 70mph
7 to 255: Not valid
Acceleration IAccelValXAxis (AccX) ATCU -65 to 65: Acceleration value
IAccelValYAxis (AccY) iERUInter2 (-6.5106.59)
|IAccelValZAxis (AccZ)
Automatic Train Control Unit (ATCU) | IAtcuUtcTime (TimeAtcu) ATCU 0: N/A
Universal Time Coordinate (UTC) )
Time iERUInter2 110 4,294,967,295: Seconds
This is the internal ATCU Coordinated
Universal Time including leap seconds.
Seconds after 01/01/1970 0:00,
synchronized on the time sent by
TCMS.
Note that this is not the time_t structure.
Car Number ICarld CAR ID Plug 0 to 255: Decimal Ascii Code
This Car Number is the info extracted | (Carld)

076MM201508
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Table 13-1 CMN Input Signals to ERU
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CMN Input Signal Description Signal Name (Screen Signal Source Telegram Value Interpretation
Abbreviation)
Car B Wheel Diameter IWheelDiamCarB ATCU 0: 28.00 in.
) ) (AtcWhdB) ) )
Wheel Diameter provided by the ATCU iERUInter2 1:27.75in.
i d on Car B Axle 1.
system measured on Car e 2: 9750 in.
3:27.25in.
4:27.00 in.
5:26.75in.
6: 26.50 in.
7:26.25in.
8:26.00 in.
9:25.75in.
10 to 19: Not valid
20:28.25in.
21:28.50 in
22 to 255: Not valid
Master Controller Unit (MCU) No | IMcuNoCoastFb ATCU 0: Coast Feedback
Coast Feedback )
(McuCst) iERUInter2 1: No Coast
Active MCU reports no coast request
feedback. Feedback
This is the ATC Coast Contact read by 2 t0 255: Not valid
Cab A Master Controller, sent on PCN
by MCU and retransmitted by ATCU for
ERU.
Cab Track Receivers Select ITrackRcvrCabA ATCU 0: No track receiver selected
(TrkRcvA) ) )
iERUInter2 1: Track receiver selected for
[TrackRevrCabB current Cab
(TrkRevB) 2 to 255: Not valid
ATCU Mode IAtcuOpeMode (AtcOpM) ATCU 0: Boot mode
Current ATC Operational Mode. iERUInter2 1: Normal
2: Rule R6.4
3: Automatic cut out
4 to 255: Not valid
ATCU Active IAtcuActiveCabA ATCU 0: Cab inactive
(AtcuCabA) . .
iERUInter2 1: Cab active
IAtcuActiveCabB 2 to 255: Not valid
(AtcuCabB)
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Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

5000 Series Rapid Transit Cars

Table 13-1 CMN Input Signals to ERU

CMN Input Signal Description Signal Name (Screen Signal Source Telegram Value Interpretation
Abbreviation)
Aspect Display Unit (ADU) Active | IAduActiveCabA ATCU 0: ADU cab inactive
Cab (AduCabA) ) )
iERUInter2 1: ADU cab active
IAduActiveCabB 2 to 255: Not valid
(AduCabB)
ATC Manual Cut-out IAtcuManCutOut ATCU 0: No cut out
(AtcCout) iERUInter2 1: ATCU cut out
2 to 255: Not valid
Cab MC Handle in Maximum Service | IMcuFsbPosCabA ATCU 0: No penalty
Brake Position ) ) ) .
(McuFsbA) iERUInter2 1: Handle in Maximum Service
Penalty Acknowledge. Brake position for current car
) . IMcuFsbPosCabB .
This Master Controller Maximum 2 to 255: Not valid
Service Brake handle position (A car)is | (McuFsbB)
an ATCU discrete input. The ATCU
sends this Penalty Acknowledge info to
the ERU.
Overspeed Penalty IBrrStatus ATCU 0: Brake applied
This is the Brake Release Relay Status | (BrrStat) iERUInter2 1: Brake not applied
(Overspeed penalty) received from )
MCU on PCN. (TW-7) 2 to 255: Not valid
When the relay is energized, the brake
is released.
Coast Command State INoCoastCmdSt ATCU 0: Coast command
(CoasCmd) iERUInter2 1: No command
2 to 255: Not valid
Cab R6.4 Switch Pressed IR64AckCabA ATCU 0: No acknowledge
Rule 6.4 Acknowledge in cab A. (IRB4A) iERUInter2 1: R6.4 acknowledge button
) . pressed in current Cab
Rule 6.4 is requested (spegd athorlzed IR64AckCabB '
up to 15 mph) when cab signal is lost. 2 to 255: Not valid
(IR64B)
Cab Alarm Enunciator Active |IAlarmActiveCabA ATCU 0: No Alarm
(AlarmA) iERUInter2 1: Alarm sounding in current Car
IAlarmActiveCabB 2: Not valid
(AlarmB)
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5000 Series Rapid Transit Cars

Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

CMN Input Signal Description

Signal Name (Screen
Abbreviation)

Signal Source Telegram

Value Interpretation

Power Call (Motion)
ATCU Motion (Power Call)

The car is attempting motion. This
variable is built by the ATCU, thanks to
the following network variables:

- Dead Man Switch hold
- Power command request from MCU

- All doors closed an locked or

bypassed

- Propulsion enabled.

IAtcuMotion
(Motion)

ATCU
iERUInter2
(TW-3)

0: Not attempting
1: Attempting motion

2 to 255: Not valid

Door Open Train Wire Command

IDoorOpenTIl ACar1

ACarDCU1

(DoorOA1) iERUInter3-A1
(TW-20)
IDoorOpenT| ACar2 ACarDCU2
(DoorOA2) iERUInter3-A2
(TW-19)
IDoorOpenTI BCar1 BCarDCU1

(DoorOB1) iERUInter3-B1
(TW-20)
IDoorOpenTI BCar2 BCarDCU2

0: No command
1: Open command

2 to 255: Not valid

(DoorUA1) iERUInter3-A1
(TW-90)
IDoorUnlockTl ACar2 ACarDCU2

(DoorUA2) iERUInter3-A2
(TW-89)
IDoorUnlockTIl BCar1 BCarDCU1

(DooruUB1) iERUInter3-B1
(TW-90)
IDoorUnlockTI BCar2 BCarDCU2

(DooruB2)

iERUInter3-B2
(TW-89)

(DoorOB2) iERUInter3-B2
(TW-19)
Door Unlock Train Wire Command IDoorUnlockTl ACar1 ACarDCU1 0: No command

1: Unlock command

2 to 255: Not valid
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Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

5000 Series Rapid Transit Cars

Table 13-1 CMN Input Signals to ERU

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

IPanelLockSwL ACar2
(PnLkLAZ2)

ACarDCU2
iERUInter3-A2

IPanelLockSwL ACar3
(PnLkLA3)

ACarDCU3
iERUInter3-A3

IPanelLockSwL ACar4
(PnLkLA4)

ACarDCU4
iERUInter3-A4

IPanelLockSwL BCar1
(PnLkLB1)

BCarDCU1
iERUInter3-B1

IPanelLockSwL BCar2
(PnLkLB2)

BCarDCU2
iERUInter3-B2

IPanelLockSwL BCar3
(PnLkLB3)

BCarDCU3
iERUInter3-B3

IPanelLockSwL BCar4
(PnLkLB4)

BCarDCU4
iERUInter3-B4

Abbreviation)
Door Panel Lock Switch Left IPanelLockSwL ACar1 ACarDCU1 0: Locked
(PnLkLA1) iERUInter3-A1 1: Unlocked

2 to 255: Not valid

Door Panel Lock Switch Right

IPanelLockSwR ACar1 ACarDCU1
(PnLkRA1) iERUInter3-A1
IPanelLockSwWR ACar2 ACarDCU2
(PnLkRA2) iERUInter3-A2
IPanelLockSwR ACar3 ACarDCU3
(PnLkRAS3) iERUInter3-A3
IPanelLockSwR ACar4 ACarDCU4
(PnLkRA4) iERUInter3-A4

IPanelLockSwR BCar1
(PnLkRB1)

BCarDCU1
iERUInter3-B1

IPanelLockSwR BCar2
(PnLkRB2)

BCarDCU2
iERUInter3-B2

IPanelLockSwR BCar3
(PnLkRB3)

BCarDCU3
iERUInter3-B3

IPanelLockSwR BCar4
(PnLkRB4)

BCarDCU4
iERUInter3-B4

0: Locked
1: Unlocked
2 to 255: Not valid
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Table 13-1 CMN Input Signals to ERU

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

ICutOutSwLNorm BCar1
(CoutLB1)

BCarDCU1
iERUInter3-B1

ICutOutSwLNorm BCar2
(CoutLB2)

BCarDCU2
iERUInter3-B2

ICutOutSwLNorm BCar3
(CoutLB3)

BCarDCU3
iERUInter3-B3

ICutOutSwLNorm BCar4

BCarDCU4

Abbreviation)
Door Panel Cutout Switch Left ICutOutSwLNorm ACar1 ACarDCU1 0: Cut Out
(CoutLA1) iERUInter3-A1 1: Normal
ICutOutSwLNorm ACar2 | ACarDCU2 2 10 255: Not valid
(CoutLA2) iERUInter3-A2
ICutOutSwLNorm ACar3 ACarDCU3
(CoutLA3) iERUInter3-A3
ICutOutSwLNorm ACar4 ACarDCU4
(CoutLA4) iERUInter3-A4

iERUInter3-B4

(CoutLB4) iERUInter3-B4
Door Panel Cutout Switch Right ICutOutSwRNorm ACar1 ACarDCU1 0: Cut Out
(CoutRA1) iERUInter3-A1 1: Normal
ICutOutSWRNorm  ACar2 | ACarDCU2 210 255: Not valid
(CoutRA2) )
iERUInter3-A2
ICutOutSWRNorm ACar3 | ACarDCU3
(CoutRA3) )
iERUInter3-A3
ICutOutSWRNorm ACar4 | ACarDCU4
(CoutRA4) )
iERUInter3-A4
ICutOutSWRNorm BCar1 | BCarDCU1
(CoutRB1) )
iERUInter3-B1
ICutOutSWRNorm BCar2 | BCarDCU2
(CoutRB2) )
iERUInter3-B2
ICutOutSwRNorm BCar3 | BCarDCU3
(CoutRB3) )
iERUInter3-B3
ICutOutSwRNorm BCar4 | BCarDCU4
(CoutRB4)
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Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
Door Open Mode I0penModeDoor ACar1 ACarDCU1 0: No status
Shows the status of the door | (DModA1) iERUInter3-A1 1: Door closed and locked
concerning its opening state. 2 Door i
IOpenModeDoor ACar2 ACarDCU2 - Looris open
(DModA2) iERUInter3-A2 3: Door is emergency unlocked
4 to 255: Not valid
I0penModeDoor ACar3 ACarDCU3
(DModA3) iERUInter3-A3
IOpenModeDoor  ACar4 | ACarDCU4
(DModA4) )
iERUInter3-A4
IOpenModeDoor  BCar1 | BCarDCU1
(DModB1) )
iERUInter3-B1
IOpenModeDoor  BCar2 | BCarDCU2
(DModB2) )
iERUInter3-B2
IOpenModeDoor  BCar3 | BCarDCU3
(DModB3) )
iERUInter3-B3
IOpenModeDoor  BCar4 | BCarDCU4
(DModB4)

iERUInter3-B4

Door Closed Summary

This signal is only sent by DCU1.

IDoorCloseSum ACar

ACarDCU1

(DCloSumA) iERUInter3-A1
(TW-21)
IDoorCloseSum BCar BCarDCU1

0: Open (DCU 1 and DCU2 Only)

1: Closed (DCU 1 and DCU2
Only)

2: Not Applicable (DCU3 and
DCU4)/Not Valid (DCU1 and
DCU2)

This signal is only sent by the DCUZ2.

(DCloSumB) iERUInter3-B1
3 to 255: Not valid
(TW-21)
Door Locked Summary IDoorLockSum ACar ACarDCU2 0: Unlocked (DCU1 and DCU2)

(DLckSumA) iERUInter3-A2
(Tw-23)
IDoorLockSum BCar BCarDCU2

(DLckSumB)

iERUInter3-B2
(TW-23)

1: Locked (DCU1 and DCU2)

2: Not Applicable (DCU3 and
DCU4)/ Not Valid (DCU1 and
DCU2)

3 to 255: Not valid
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Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
Device instance indication | IDevinstance ACar1 ACarDCU1 1 to 255: Device instance
(enumeration) )
(DevinsA1) iERUInter3-A1
e.g. DCU1 =01
Maxi device | is 4 IDevinstance ACar2 | ACarDCU2
aximum device instance is 4. (DevinsA2) .
iERUInter3-A2
IDevinstance ACar3 | ACarDCU3
(DevinsA3) )
iERUInter3-A3
IDevinstance ACar4 | ACarDCU4
(DevinsA4) )
iERUInter3-A4
IDevinstance BCar1 | BCarDCU1
(DevinsB1) )
iERUInter3-B1
IDevinstance BCar2 | BCarDCU2
(DevinsB2) .
iERUInter3-B2
IDevinstance BCar3 | BCarDCU3
(DevinsB3) )
iERUInter3-B3
IDevinstance BCar4 | BCarDCU4
(DevinsB4) )
iERUInter3-B4
No Motion Relay Status INmrSt LSI 0: Does not allow door opening
) (i.e., car is in motion)
(INmrSt) iERUInter4
. 1: Allows door opening (i.e., car is
(Pair Lines) immobile)
2 to 255: Not valid
ATC Car ID ICarld ATCU 0 to 255: Decimal Ascii Code
Car Identifier iERUInter2
This Car Number is the info extracted
from IPTDir train  configuration
structure, retransmitted by the ATCU for
the ERU.
e.g. "5001"
ATCU Cut Out Switch IAtcuCutOutSw BCar TCMS 0: No cut out

ATCU is manually cut out.

Only the B car sends this information.

(ATCCoutB)

ICCUOStatus-B

1: ATCU cut out
2 to 255: Not valid
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Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
Active Cab Type ICabActive A/BCar TCMS 0 to 255: Decimal Ascii Code
(A-car or B-car) (TcmCab) ICCUOCStatus
Active Cab Type (A or B) -A or -B
This field contains the car number of the
active cab car.
e.g "5001"
If there is no active cab in the train, the
string contains Null characters.
Side Trip Emergency (STEM) Bypass | IStemByp ACar ACarTCMS 0: Bypass inactive
Only the active cab sends this info. (StemBypA) ICCUOStatus-A 1: Bypass active

IStemByp BCar

BCarTCMS

2 to 255: Not valid

(StemBypB) ICCUOStatus-B
Door Bypass IDoorByp ACar ACarTCMS 0: Door normal
Only the active cab sends this info. (DoorBypA) ICCUOStatus-A 1: Door bypassed

IDoorByp BCar

BCarTCMS

2 to 255: Not valid

(DoorBypB) ICCUOStatus-B
ATCU Bypass IAtcuByp ACar ACarTCMS 0: Bypass inactive
Only the active cab sends this info. (AtcuBypA) ICCUOStatus-A 1: Bypass active

IAtcuByp BCar

BCarTCMS

2 to 255: Not valid

(AtcuBypB) ICCUOStatus-B
Bypass Activation Switch (BAS) IBypActivSw ACar ACarTCMS 0: Bypass inactive
Only the active cab sends this info. (BASA) ICCUOStatus-A 1: Bypass active

IBypActivSw BCar (BASB)

BCarTCMS
ICCUOStatus-B

2 to 255: Not valid

Smart Card ID information IScrldinfo A/BCar TCMS 0 to 9: Value
If the information is not available (No | (SCard) ICCUOStatus 10 to 255: Not valid
card swiped), then each byte is null.
-Aor -B
Each array element represents a
number from 0 to 9.
Propulsion Enable Bypass IPropEnableByp ACar ACarTCMS 0: Bypass inactive
Only the active cab sends this info. (PropBypA) ICCUOStatus-A 1: Bypass active

IPropEnableByp BCar
(PropBypB)

BCarTCMS
ICCUOStatus-B

2 to 255: Not valid
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Table 13-1 CMN Input Signals to ERU

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

CMN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
Control Cut Out Status ICntrlICutOutSt ACar | ACarTCMS 0: No cut out
(CtiCoutA)
ICCUOStatus-A 1: Cut out

ICntrlICutOutSt BCar

BCarTCMS

2 to 255: Not valid

(CtiCoutB) ICCUOStatus-B
Brake Manual Release Relay Status IBmrrSt ACar ACarTCMS 0: Close
(BmrrA) ICCUOStatus-A 1: Open

IBmrrSt BCar
(BmrrB)

BCarTCMS
ICCUOStatus-B

2 to 255: Not valid

Spare Discretes
4 spare Bits.

Spare bit corresponding to input read by
the LCU on its I/0.

ISpareBits1 ACar
(SpareA1)

ISpareBits2 ACar
(SpareA2)

ISpareBits3 ACar
(SpareA3)

ISpareBits4 ACar
(SpareA4)

ACarTCMS
ICCUOStatus-A

0: Input not activated
1: Input activated

2 to 255: Not valid

ISpareBits1 BCar
(SpareB1)

ISpareBits2 BCar
(SpareB2)

ISpareBits3 BCar
(SpareB3)

ISpareBits4 BCar

BCarTCMS
ICCUOStatus-B

(SpareB4)
System UTC Time ISystemUtcTime A/BCar TCMS 0: No time available
. . ) ) ) (TimeSystem)
Coordinated Universal Time including ICCUOStatus 1 to 4,294,967,295: Number of
leap seconds. Aor-B seconds

Seconds after 01/01/1970 0:00.

Note that this is not the time_t structure.
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Limited Rights Legend
Contract C04FI100110620
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Table 13-2 Propulsion Control Network (PCN) Input Signals to ERU

PCN Input Signal Description

Signal Name (Screen

Signal Source Telegram

Value Interpretation

Abbreviation)
Emergency Brake IEmerBrake MC 0: Handle not in emergency
) position
(EmBrake) iERUInter5
1: Handle in emergency position
2 to 255: Not valid
Maximum Brake IMaxBrakePos MC 0: Handle not in maximum brake
. position
(MaxBrake) iERUInter5
1: Handle in maximum brake
position
2 to 255: Not valid
Minimum Brake IMinBrakePos MC 0: Handle not in minimum brake
. . position
(MinBrake) iERUInter5
1: Handle in minimum brake
position
2 to 255: Not valid
Coast ICoastPos MC 0: Handle not in coast
(Coast) iERUInter5 1: Handle in coast
2 to 255: Not valid
Minimum Power Level IMinPwr MC 0: Handle not in minimum power
(MinPwr) iERUInter5 1: Handle in minimum power
2 to 255: Not valid
Maximum Power Level IMaxPwr MC 0: Handle not in maximum power
(MaxPwr) iERUInter5 1: Handle in maximum power
2 to 255: Not valid
MCU Handle Key Off Position IHandleKeyOffPos MC 0: Handle not in off position
(MHandle) iERUInter5 1: Handle in off position

2 to 255: Not valid
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5000 Series Rapid Transit Cars

Table 13-2 Propulsion Control Network (PCN) Input Signals to ERU

PCN Input Signal Description Signal Name (Screen Signal Source Telegram Value Interpretation
Abbreviation)
Encoder Value IEncoderVal MC 0 to 13: Off position
This field represents the encoder value | (Encoder) iERUInter5 14 to 27: Emergency Brake
of the handle position sent by the MCU. Position
Default: 0 28 to 49: Maximum Service Brake
Position
50 to 102: Brake Zone
103 to 113: Minimum Brake
Position
114 to 134: Coast Position
135 to 145: Minimum Power
Position
146 to 221: Power Zone
222 to 232: Maximum Power
Position
233 to 65535: Not valid
Deadman Switch IDeadManAct MC 0: Dead man switch not active
. . . . (Not rotated)
Maximum service brake is commanded | (Deadman) iERUInter5
by PBCU when dead man switch is not TW-7 1: Dead man switch active
active. (TW-7) (Rotated)
2 to 255: Not valid
Track Brake Command ITrackBrakeCmd MC 0: No command
(TrBrake) iERUInter5 1: Command
(TW-14) 2 to 255: Not valid
Brake Release Relay Status IBrrSt MC 0: Brakes not released
Brake Release Relay Status (Over | (BrrSt) iERUInter5 1: Brakes released
speed penalty brake). )
(TW-7) 2 to 255: Not valid
When the relay is energized, the brakes
are released.
Propulsion is Enabled IPropEnable MC 0: Propulsion disabled
(PropEna) iERUInter5 1: Propulsion enabled
2 to 255: Not valid
Door Bypass IDoorByp MC 0: Door normal
(DoorByp) iERUInter5 1: Door bypassed
2 to 255: Not valid
Door Closed and Locked IDoorClosedLocked MC 0: Door open or unlocked
(DCloLck) iERUInter5 1: Door closed and locked
2 to 255: Not valid
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5000 Series Rapid Transit Cars

Table 13-2 Propulsion Control Network (PCN) Input Signals to ERU

PCN Input Signal Description Signal Name (Screen Signal Source Telegram Value Interpretation
Abbreviation)
No ATO Coast Request INoAtoCoastReq MC 0: ATO coast request
(ATOCst) iERUInter5 1: No ATO coast request
2 to 255: Not valid
Hydraulic Friction Brake Applied INoFrictionBrake MC 0: Brake applied
(FrBrake) iERUInter5 1: Brake not applied
(TW-13) 2 to 255: Not valid
Power Effort Command Value IPwrCmdVal MC 0: Coast if IBrakeCmdVal = 0
Power Effot Command Value in | (Power) iERUInter5 1 to 100: Power command
percentage. )
101 to 255: Not valid
Command Modified ICmdModified MC 0: Not modified
This status is set to indicate fields are | (CmdMod) iERUInter5 1: Modified
dified intentionally.
modiied infentionally 2 to 255: Not valid
Brake Effort Command Value IBrakeCmdVal MC 0: Coast if IPwrCmdVal =0
Brake Effot Command Value in | (BrkCmdVal) iERUInter5 1 to 100: Brake command
percentage. .
101 to 255: Not valid
Reverser in Reverse Position IRevRevPos MC 0: Not Reverse
(RevRev) iERUInter5 1: Reverse
(TW-2) 2 to 255: Not valid
Reverser in Forward Position IRevFwdPos MC 0: Not Forward
(RevFwd) iERUInter5 1: Forward
(TW-1) 2 to 255: Not valid
MCU Low voltage Within Operating | ILowVoltinOpRng MC 0: Low voltage out of operating
Range ) range
(LowVIt) iERUInter5
1: Low voltage within operating
range
2 to 255: Not valid
Type of Car onto which MCU is | IMcuCarType MC 0: Not valid
installed )
(CarType) iERUInter5 1: A Car
2: B Car
3 to 255: Not valid
ATC Switch Bypass IAtcSwByp MC 0: ATC bypass not active
(AtcByp) iERUInter5 1: ATC bypass active
2 to 255: Not valid
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Table 13-2 Propulsion Control Network (PCN) Input Signals to ERU

PCN Input Signal Description Signal Name (Screen Signal Source Telegram Value Interpretation
Abbreviation)

MC Protocol Version IProtocolVersion MC 0: Not valid
Incremented if new protocol is iERUInter5 1 to 99: Version number
incompatible to previous protocol . .
version. 100 to 255: Not valid
MC Protocol Release IProtocolRelease MC 0 to 99: Release number
Incremented if new protocol has iERUInter5 100 to 255: Not valid
additional  functions but is still
compatible.
MC Circular Counter ICircCntr MC 0 to 65535: Counter value
This is a 16 bit counter which is iERUInter5

incremented at each transmission. The
counter wraps to zero (0) when the
maximum value is reached (65535).

MC Unique Identifier IMculd MC 0 to 47: Not valid

Unique MCU Identifier. Shall be iERUInter5 48 to 57: Ascii code number
independent of the network interface

used for transmission. 58 to 255: Not valid

This is a 6 digits number. Each digit is
an array element. Only 6 elements are
used, the others are null.

WWYYUU (WW = week of the year, YY
= year, UU = Unit or serial number for

that week).
Table 13-3 ERU Output Signals
Signal Description Signal Name Signal Source Value Interpretation
Event Recorder Operational Fault IEruOpModeOk Event Recorder 0: No event
1: Event active
2 to 255: Not valid
Ethernet Channel #1 Communication | FComEthernet1 Event Recorder 0: No failure
Fault )
1: Failure
2 to 255: Not valid
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Table 13-3 ERU Output Signals

Signal Description Signal Name Signal Source Value Interpretation
Ethernet Channel #2 Communication | FComEthernet2 Event Recorder 0: No failure
Fault .
1: Failure
2 to 255: Not valid
Counter incremented once per | ISystemLifeSign Event Recorder 0 to 65535: Counter value

output message packet sent.

The system sets this counter to zero
after reset including power-up and
increment it with every application
cycle.

When attaining the max value, the
counter wraps around to zero.

Watch Dog Reset Counter FWatchDogRstCnt Event Recorder 0 to 255: Counter value
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13.4 COMPONENT DESCRIPTION

13.4.1 Event Recorder Unit

The Event Recorder Unit (ERU) is an electronic device that keeps an ongoing record of the status of train
systems. The unit continuously receives information coming through connecting cables from transducers,
train wires, switches, and the car and train networks. Information is stored in the ERU permanent memory
and can be downloaded to a Portable Test Unit (PTU) for analysis.

The ERU is an orange steel box installed in every B-car of a married pair (see Figure 13-4 "ERU Location").
It is designed, built, and sealed to withstand extreme conditions (fire, shock, immersion, and impact) that
may be encountered in an accident and to preserve the information it has stored. This information is
available for later retrieval and analysis using specialized software. The ERU fits into the equipment rack
located underneath the passenger seats on the cab side No. 2 end of the B-car. The unit is grounded to the
locker frame.

The ERU has the following interfaces; two Ethernet ports for reception of train status data, one Ethernet test
port for data download to PTU, one power supply port, one CAR 1D Plug port, one ground lead stud, and
various indicator lights.

Table 13-4 Event Recorder Unit Technical Data

Crash-hardened Memory Module

128 megabyte (MB) (two memory blocks of 48 MB and one of 32 MB for auxiliary files)

Circular Buffer Memory Capacity:

48 consecutive non-stop hours or three days @ a rate of 16 hours/day

Single Board Computer (Processor
Module)

Model EP930

PC/104 form factor module with PC/104 compatible parallel bus

Low-power ARM9 processor with Memory Management Unit (MMU) running at 200 MHz

20 Digital Input / Output lines

Programmable Watchdog timer

High level C language programming support (GCC compiler)

RAM 64 MB of high speed RAM
FLASH Non-volatile Memory 128 MB
Operating System Linux

Electrical Connectors

Ethernet 1 and Ethernet 2

Ethernet Test Port (BTE/PTU)

Power

CarID

Ethernet Port Type

10/100 Base-TX

Serial Peripheral Interface

Yes

Serial Communication Port

Yes

Data Download

Through Ethernet port formatted in HTTP protocol @ a rate of 1 MB/sec
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Table 13-4 Event Recorder Unit Technical Data

Periodic Testing Continuous self-test mode

Housing Ya-in thick rolled steel enclosure (painted International Orange)

Impact resistant to 25,000 Ib

Operating Voltage 37.5Vdc

Weight 331b

Height 8in.

Width 10.25 in. (excluding brackets)
Length 10.6 in. (excluding interface ports)
Operating Temperature -13 °F - +158 °F
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NO. 1 END

076L-761-003 Rev 1

Figure 13-4 ERU Location
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13.5 OPERATING PROCEDURES

076L-000-020 Rev 3

076MM201508

P-SWITCH P48 (EVENT RECORDER)
TO CLOSE (ON POSITION)

MASTER CONTROLLER TO ON

(REVERSER KEY IN "FWD" OR "REV").

37.5VDC PRESENT.

EVENT RECORDER POWERED UP.

B-CAR

OPEN SEATBOX
PANEL NEAR NO.3 SIDE DOOR
WITH VID-KEY.

CHECK FOLLOWING ON UNIT:
- CARID PLUG IS CONNECTED.

- "POWER" LED (GREEN LIGHT) IS ON.

- "FAULT STATUS" LED (RED LIGHT)
BLINKS EVERY 6 SECONDS.

EVENT RECORDER SYSTEM
OPERATIONAL.

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

Figure 13-5 Event Recorder System Operational Sequence Diagram
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13.6 EQUIPMENT AND MATERIAL REQUIREMENTS
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The Equipment and Material Requirements section provides general safety precautions and lists in tabular
format the special tools and equipment, supplies, and consumables necessary during the maintenance of on-car

components.

Table 13-5 List of Tools, Test Equipment, and Special Equipment

Procedure Tool, Test Equipment, or Special Equipment Part Number
13.7.2 "Test Event Recorder Unit" ERU PTU
ERM software, latest version 63177
M12 to RJ45 Ethernet cable
13.9.1 "Replace Event Recorder Unit" Harting tool
13.9.3 "Overhaul RTC PCB Assembly" Multimeter
Table 13-6 List of Consumables
Procedure Consumable Part Number
13.9.1 "Replace Event Recorder Unit" Lockwashers C227-204
Lockwashers C227-205
Torque-Seal 78020006S
Electric joint compound
13.9.2 "Overhaul Crash Hardened Memory Module Cable ties 43353-2B
Assembly"
Cable ties 43353-7
13.9.3 "Overhaul RTC PCB Assembly" Cable tie 43353-2B
Blue Loctite, #425
Table 13-7 List of Supplies
Procedure Supply Part Number
13.9.1 "Replace Event Recorder Unit" ERU 850002918
13.9.2 "Overhaul Crash Hardened Memory Module Crash Hardened Memory Module Assembly 54540-01

Assembly"

13.9.3 "Overhaul RTC PCB Assembly"

Battery, Lithium LTC-7P

LTC-7P LITHIUM
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13.7 PREVENTIVE MAINTENANCE

The following procedures describe tasks performed during the maintenance of the car. These may include, but are
not limited to, the following tasks:

* Inspections
» Servicing

* Tests

*  Adjustments
+ Alignments

e Calibrations.

Description Serv. Interval Use on Code
(days)
13.7.1 "Inspect Event Recorder Unit" 60 B-car
13.7.2 "Test Event Recorder Unit" 60 B-car
13.9.1 "Replace Event Recorder Unit" AR B-car
13.9.2 "Overhaul Crash Hardened Memory Module Assembly" AR B-car
13.9.3 "Overhaul RTC PCB Assembly" 3103 B-car
13.9.4 "Overhaul SBC PCB Assembly" 3650 B-car
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13.71 Inspect Event Recorder Unit

Applicable Car(s): B-car

Equipment Condition(s)
A-car active cab. Refer to System 05, Electrical System for "Service Cab Activation"”.
P-switch P48 EVENT RECORDER set to ON (B-car only).

Inspect Event Recorder Unit (ERU)

BAC7620

Figure 13-6 ERU Power and Fault LEDs

1. Visually inspect front panel POWER and FAULT LEDs:

Green POWER LED (1) should be illuminated (steady on). FAULT LED (2) should flash every six seconds. This
indicates that the ERU is powered up and running normally with no fault conditions.

No further action required in this situation.
2. If green POWER LED (1) is not on, proceed as follows:
A. Ensure power is being supplied to ERU from train (P-switch P48 EVENT RECORDER is ON ).

B. Inspect connectors on all harnesses connected to ERU. They must all be firmly engaged, and harnesses
must not be pinched or damaged. If connections are intact and LED still does not turn on, ERU power supply
module is potentially faulty.

C. Access STATUS : EVENT RECORDER screen and EVENT : EVENT RECORDER screen from
MAINTENANCE SCREEN on Train Operator's Touch Screen (TOTS) to confirm unit is faulty.

END OF PROCEDURE
Follow-on Tasks
None
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13.7.2 Test Event Recorder Unit

Applicable Car(s): B-car

Equipment Condition(s)
A-car active cab. Refer to System 05, Electrical System for "Service Cab Activation"”.
P-switch P48 EVENT RECORDER set to ON (B-car only).

Special Equipment

ERU PTU

ERM software, 63177, latest version
M12 to RJ45 Ethernet cable

Test Event Recorder Unit (ERU)

NOTE

Cab must stay active during this test otherwise power to the
event recorder will be cut after five minutes of inactivity.

1. Using compartment access key, access ERU by opening underseat compartment door.

BAC7621

Figure 13-7 Connect PTU to ERU
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2. Remove cap (1) from test port (2) and connect Ethernet cable (3) from PTU to ERU at ETHERNET TEST PORT
on front cover.
3. Start PTU and ERM program. Startup time varies depending on the speed of the computer. ERM program will
open up at the Summary screen.
ol x]
File  Wiew Help
~| Event Recorder Summary Data
Application Id "CTABDDO"
ER Carld E547
SCI Ver PM 1.06
System Fault Code
Recording State Recording
Self Test Unable to Run
Self Test Inhibited Inhibited
11-02-2009 16:33:35 UTC| Connected | Application: "CTA5000" | Version: 106 | Car #: 8541 | Serial; "None” | Recording | No Faults
Figure 13-8 Summary Screen
4. Confirm car ID number shown on screen corresponds to car.
5. Examine Summary screen and make a note of any fault codes.
6. From drop-down list, select 020 Faults screen to view any ERU faults.
7. Make a note of any faults shown on screen.
8.

From drop-down list, select 030 Realtime screen. The screen displays current values for all the signals
recorded by the event recorder.
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F#. Event Recorder Manager (CTAS000) ]

(ol x]
File  Wiew Help
020 Faults ~| Event Recorder Faults

|
System Fault Code
Processor Module Faults

ID Faults

CHM Faults

Ethemet Fault

Other Faults

IP Address "10.027"

Figure 13-9 Faults Screen (no faults shown)

NOTE

Many signals will not be active because the train is stopped

during testing, and many values will not be displayed. This is
to be expected.

NOTE

The program allows you to customize how the realtime data

is shown onscreen. See options in View menu and set to suit
your purposes.

9. From file drop-down list, select Data Report and press Download button. File will appear on screen and is
saved to the PTU.

10. Check time shown for both computer clock and real-time clock. If they are more than a couple of seconds
different, then synchronize them by pressing the Set button (adjacent to the time to be set.)
11.

12.
13.
14.

From drop-down list, select screen 090, Clock Set. Setting clock requires a valid password.
Choose from available options and select Download. File is saved to PTU.

From drop-down list, select screen 040, Event Data Download.

Upon completion of test, exit and close program, close PTU and disconnect cable (3) between PTU and ERU.
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¥l Event Recorder Manager (CTAS000) B =

File

View  Help

Realtime Event Recorder Data for A-Car

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

=10l x|

Real Time Clock
ATC |AtculhcTime
MC1.IMcuCarType
ER Carid

TCMS ICabActive
. _______________________________________|
ATC ICarid fai

11-02-2009 16:39:09
1570-01-01 00:00:00

8547

ATC |Accel Val XAxiz 0.01g)
ATC |Accel Val YAxis 0.0(g)
ATC |AccelVal 7 Axis 0.0 {g)
ATC |AduActiveCabA

ATC 10verSpeedAlarmA

ATC lAtcuActiveCabA

ATC IAtcuManCut Out

ATC 1AtcuMotion

ATC |AtcuOpeMode Unkniown
ATC IPenaltyBrake-TW7  Brake
ATC ICarActual Speed 0.00 {mph)
ATC ICarAllowSpeed 0 {mph})
ATC ICoastContactorSta... Coast
ATC IMcuFsbPosCabA

ATC INoCoastCmdSt Coast
ATC IR64AckCabA

ATC ITrackRcwrCabA

ATC IWheelDiamCarB 28.00 {in)

|
DCU_ATICutOut Swl Norm  Cutout

DCU_AT.1CutOut SwRNomm  Cutout

DCU_AI1 IDevinstance a

DCU_A1 IDoorClosedSu_. Open
DCU_A1.IDoorOpenTl
DCU_A1.IDoorUnlock Tl
DCU_A1.I0penModeDoor
DCU_A1.IPanellockSwl  Locked

DCU_AT.IPanellockSwR  Locked
|
DCU_AZ ICutOut SwlNorm  Cutout

DCU_AZ ICutOut SwRNomm  Cutout

DCU_AZ IDevinstance 0

DCU_AZ2 I1DoorLockedSu... Unlocked

DCU_AZ IDoorOpenTl

DCU_A2 IDoorUnlockT
DCU_AZ.I0penModeDoor

DCU_AZ IPanellockSwl  Locked
DCU_AZ IPanellockSwR  Locked

DCU_A3.ICutOutSwlNom Ctout
DCU_A3.ICutOut SwRNom  Cutout
DCU_A3.IDevinstance a
DCU_A3.I0penModeDoor
DCU_A3 IPanellockSwl  Locked
DCU_A3 IPanellockSwR  Locked

DCU_A4 ICutOut Swl Norm  Cutout
DCU_A4 ICutOut SwRNorm  Cutout
DCU_A4 IDevinstance (7]
DCU_A4. [OpenModeDoor

DCU_A4 IPanellockSwl  Locked
DCU_A4 IPanellockSwR  Locked

LS1.INcMotionRelayStatus  Motion

MC1 1AtcSwitchByp
MC1.1BrakeCmdVal
MC1.1BrSt
MC1.ICircCntrChange
MC1 ICmdModified
MC1.ICoastPos

MC1 IDeadManAct

MC1 IDoorBypass

MC1 IDoorClosedLocked
MC1 IEmerBrake

MC1 IEncoderVal

MC1 IHandleKeyOff Pos
MC1 ILowVoltInOpRng
MC1.IMculd

MC1 IMaxBrakePos
MC1.IMinBrakePos

MC1 IMinPwr
MC1_IMaxPwr

0%
Brake
Mo Change

Off

OutRange

MC1.ICoastContactorSta....

MC1 INoFrictionBrake
MC1.IPropEnable

MC1 IProtocolRelease
MC1.IProtocolVersion
MC1 IPwrCmdVal

MC1 IRevFwdPos-TW1
MC1.IRevRevPos-TW2
MC1.1TrackBrakePushB.__

CoastReq
Brake

002

Prop_A IAdeWheelDiam
Prop_A IBrkHydPress
Prop_A ICarMileage
Prop_A IEmergER1St-T .
Prop_A IOut YellowLight
Prop_A IPropMode

TCMS_A IAtcuByp
TCMS_A IBmrSt
TCMS_A IBypActivSw
TCMS_A ICniriCutOut St
TCMS_A IDoorByp
TCMS_A IPropEnableByp
TCMS_A IScridinfo
TCMS_A IStemByp
TCMS_A ISpareBits1
TCMS_A ISpareBits2
TCMS_A ISpareBits3
TCMS_A ISpareBits4

28.00 {in)
0 fpsi)

O ft)
EBrake
Off

Coast
0.0 {mph)
0{Hz)

0.0 (bt)
0.0 b4t

Close

0.0000000

11-02-2009 16:39:09 UTC| Connected | Appication: "CTAS000" | Version: 1.06 | Car #: 8541 | Serial: None” | Mot Recarding | No Faults

Figure 13-10 Realtime Screen (typical)

NOTE

Downloaded data may be reviewed to confirm that all
required signals are being recorded, or as part of any periodic
inspection of the recorder.

15. Replace cap (1) onto test port (2).

Follow-on Tasks
None
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F#. Event Recorder Manager (CTAS000) - ;Igll

File | View | Help
Engineering Units ime Event Recorder Data for A-Car
Eecliciton 16:43.19 DCU_AZ IDoorOpenTl MC1_ICoastContactorSta... CoastReq
Raw Units 1 00:00:00 DCU_A2 IDoorUnlock Tl MC1.INoFrictionBrake Brake
Signal Mames DCU_A2 10penModeDoor R D
SR DCU_AZ IPanellockSwl  Locked MC1_IProtocolRelease 0
DCU_AZ IPanellockSwR  Locked MC1_IProtocol Version a
Looice fome I N 14C 1 [PwrCmdVal 0(%)
Interpret DCU_A3 ICutOut SwLNorm  Cutout MC1.IRevFwdPos-TW1
DCU_A3 ICutOut SwRNorm  Cutout MC1.IRevRevPos-TW2
Show Local Time DCU_A3.IDevinstance g MC1.ITrackBrakePushB.__
Fo DCU_A3 I0penModeDoor ]
e DCU_A3 IPanellockSwl  Locked Prop_A lAdeWheelDiam  23.00 fin)
DCU_A3 IPanellockSwR  Locked Prop_A IBrkHydPress 0 fpsi)
I Prop_ A ICarMileage 0 )
DCU_A4.ICutOut SwLNorm  Cutout Prop_A IEmergER1St-T..  EBrke
ATC.1AtcuMotion DCU_A4.ICutOut SwRNorm  Cutout Prop A lOutYellowlight  Off
ATC IAtcuOpeMode Unknown DCU_A4. IDevinstance a Prop A IPropMode Coast

Figure 13-11 Customizing Realtime Data Viewing Options

Event Recorder Manager (CTAS000) TN ) 2 |EI|1[
File | Wiew Help
Recorder Address ... nt Recorder Summary Data
e,
; C TARDDO™
Reload Configuration
|28
Data Report F = —————————
06
Maintenance Log Report
Recorder Configuration
ot Recording
Set Conhol Security ]
! Inable to Run
Exit
ibited

Figure 13-12 ERU Realtime Data Report Screen
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030 Realtime A-Car
11-02-2009 17:11:05  Car

Time Zone: UTC

Channel

Real Time Clock
ATC.IAtcuUtcTime
MC1.IMcuCarType
ER.Carld
TCMS.ICabActive

ATC ICarld
ATC.IAccelValXAxis
ATC.IAccelValYAxis
ATC.IAccelValZAxis
ATC.IAduActiveCabA
ATC. 10verSpeedAlarmA
ATC.IAtcuActiveCabA
ATC.IAtcuManCutOut
ATC.IAtcuMotion

ATC lAtcuQOpeMode
ATC. IPenaltyBrake-TW7
ATC ICarActualSpeed
ATC. ICarAllowSpeed

4

1 of 3 b M

CTA5000 Recorder

5000 Series Rapid Transit Cars

MNone

Value

11-02-2009 17:11:04
1970-01-01 00:00:00

8541

0.0 (g)
0.0 (g)
0.0 (g)

Unknown
Brake

0.00 {mph)
0 {mph)

Figure 13-13 Sample Data Report Screen
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Figure 13-14 Clock Set Screen

|21 Event Recorder I lanager (CTAS000)

rom: -
To: [11022008 16:25:52 =+

R —

Figure 13-15 Data Download Screen
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13.8 TROUBLESHOOTING

The following table contains instructions to be used as guidance in locating troubles, estimating their probable
causes, and suggesting corrective actions for on-car components.

The Troubleshooting (TS) table, if need be, encompasses all the components of a given system and always has the
same heading structure, which is:

FAULT CODE - (If applicable) This is the first column of the table and it lists the fault code(s) that the
Monitoring and Diagnostics System reports to the user by means of a screen. This screen could be in the
cab, the HVB or APS fault code displays, or part of a plug-in Portable Test Unit (PTU).

Some symptoms might not be reported by the Diagnostic System (e.g., some parts of the mechanical
systems). Fault codes followed by an asterisk are Internal System Events. They are not reported on the
TOTS and are only accessible using the system PTU. Internal System Events are not always applicable.

Where applicable in the first column, between parentheses, is the identification of the system that supplied
the fault code. For example: 0001 (CCU).

SYMPTOM - The second column of the table lists various failure symptoms.

Symptoms can be of two kinds. The first kind of symptom comes from the monitoring system screen fault
code description labels. This is the information that is seen on the screen if a Fault Code is available. Note
that, if the description label proves to be too cryptic, information clarifying the exact nature of the fault can
be added.

The second kind of symptom occurs when the train operator or end user notices a problem with one of the
systems on the consist. The Symptom field is filled in the same fashion as above except that there exists
no Fault Code.

POSSIBLE CAUSE - This is the third column of the table and it suggests at least one possible cause for a
particular Symptom. These causes can occur at different maintenance levels. For example:

» System level cause - System "X" not responding to Car Network
»  Subsystem level cause - Subsystem "Y" not reading sensor
» Component level cause - Component "Z" faulty.

CHECK/INSPECT - This is the fourth column of the table and it suggests action(s), such as an inspection or
a test, for each Cause.

CORRECTIVE ACTION - This is the fifth column of the table and it suggests corrective action(s) for each
Cause.

There are four levels of diagnosis for troubleshooting using the TCMS system.

View real-time fault information on the TOTS Operation screen. A component fault is indicated by
illumination of a system button in an amber color for a minor fault or in red for a major fault.

Log in to TOTS Maintenance screens to view system status and detailed fault code information. Use the
Event View screen to see Help Text on individual fault conditions. Press anywhere on the fault description
line to view detailed Help Text about a specific fault.

Use a Portable Test Unit (PTU) diagnostic system to connect to the train network on the A-car or B-car. The
PTU enables system troubleshooting, data retrieval and viewing, configuration parameter modification, and
software upgrading.

In addition, the Wayside Diagnostic System can communicate system status information from the car to a
remote maintenance site.

If TCMS fault code Help Text lacks sufficient detail, physical examination of the component may indicate the cause
of the fault.
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Fault Code Symptom Possible Cause Check / Inspect Corrective Action
1 Ethernet Port 1 1- Ethernet cable not 1- Verify Ethernet cable is Replace ERU.13.9.1
Communication connected connected and Port 1 green | "Replace Event Recorder
1- On ERU: Ethernet port 2- Ethernet cable not LED is ON Unit"
green LED is OFF connected to 10BaseT port | 2- Verify Ethernet switch is .
. . setto 10 Base T Replace Ethernet unit
2- On PTU: Fault 1443 3- Ethernet unit switch OFF switch.
. 3- Verify Ethernet unit switch
Event Type: RESTRICTIVE | 4- Hardware failure on ERU is ON.
(i.e., a fault requiring Ethernet port
immediate remedial action) )
5- Hardware failure on
switch Ethernet port.
2 Ethernet Port 2 1- Ethernet cable not 1- Verify Ethernet cable is Replace ERU.13.9.1
Communication connected connected and Port 2 green | "Replace Event Recorder
1- On ERU: Ethernet port 2- Ethernet cable not LED is ON Unit"
green LED is OFF connected to 10BaseT port | 2- Verify Ethernet switch is .
. . setto 10 Base T Replace Ethernet unit
2- On PTU: Fault 1453 3- Ethernet unit switch OFF switch.
. 3- Verify Ethernet unit switch
Event Type: RESTRICTIVE | 4- Hardware failure on ERU is ON.
Ethernet port
5- Hardware failure on
switch Ethernet port.
3 Reset Counter Abnormal ERU hardware or | Check if watchdog counter | Replace ERU.13.9.1
ERU stops functioning for software error which could increases by more than 1 "Replace Event Recorder
20-60 seconds while it not be corrected by normal | during a given week. Unit"
reboots. built-in error handling. If problem persists after
ERU replacement check
Event Type: INFORMATIVE external wiring for abnormal
noise or surges and spikes.
4 Event Recorder Non Fault 1430: Error in None. Fault 1430: Install new
Operational processor module Software software package.
Red fault LED SOLID. PTU | configurable ltem (SCI)
displays related event code | memory Fault 1431, 1432 and 1520:
and description. . Replace ERU. 13.9.1
Fault 1431: Real-time clock "Replace Event Recorder
Event Type: RESTRICTIVE | board failure Unit"
Fault 1432: Battery failure Fault 1433: Check input
voltage. Replace ERU.
Fau]t 1433: Low voltage at 13.9.1 "Replace Event
ER input Recorder Unit"
Fault 14.34: I.dfanti.fication Fault 1434: Check
P'%‘g or identification board identification plug. Replace
failure ERU. 13.9.1 "Replace Event
Fault 1520: Crash hardened Recorder Unit"
memory module failure.
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13.9 CORRECTIVE MAINTENANCE

The following procedures describe the removal and installation of on-car components.

13.9.1 Replace Event Recorder Unit

Applicable Car(s): B-car

Equipment Condition(s)
Married Pair deenergized.
P-switch P48 EVENT RECORDER set to OFF.

Tool(s)
Harting tool

Supplies
ERU, 85000291S

Consumable(s)
Lockwashers, C227-204
Lockwashers, C227-205
Torque-Seal, 78020006S
Electric joint compound

NOTE

Unit weighs approximately 33 Ib.

Remove Event Recorder Unit (ERU)

Limited Rights Legend
Contract C04FI100110620
Bombardier Transit Corporation

1. Using compartment access key (VID1), access ERU (1) by opening underseat compartment door (6).

Disconnect Ethernet connectors ETHERNET 1 and ETHERNET 2.

Detach quarter-turn cable connectors POWER and CAR ID.

2
3
4. Remove screw (7), lockwasher (8), washer (9), and ground lead (10). Discard lockwasher.
5

Remove four screws (2), four lockwashers (3), and four flat washers (4) to remove ERU (1). Discard

lockwashers.

Install ERU

1. Install ERU (1) using four screws (2), four new lockwashers (3), and four flat washers (4). Torque to seven ft-Ib

and apply Torque-Seal (5).

2. Install ground lead (10) with screw (7), new lockwasher (8), and washer (9).

3. Connect quarter-turn cable connectors POWER and CAR ID onto front face of ERU (1).
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CAUTION

Do not overtighten Ethernet M12 connectors. Connectors can
be damaged by excessive force.

4. Attach Ethernet cables (M12 connector) to connectors ETHERNET 1 and ETHERNET 2.
Torque M12 connector collars with a calibrated Harting tool.

6. SetP-switch P48 EVENT RECORDER to ON and make sure ERU (1) operates normally (i.e., POWER light is
continually illuminated and FAULT LED flashes every six seconds).

7. Using compartment access key, close and lock underseat compartment door (6).

END OF PROCEDURE
Follow-on Tasks

Refer to 13.7.2 "Test Event Recorder Unit".

076MM201508 13-49



Limited Rights Legend
Contract C04F1100110620

5000 Series Rapid Transit Cars Bombardier Transit Corporation

076L-761-004 Rev 3

Figure 13-16 ERU Replacement
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13.9.2  Overhaul Crash Hardened Memory Module Assembly

Applicable Car(s): B-Car

Equipment Condition(s)
Event Recorder Unit (ERU) removed from car.
Refer to 13.9.1 "Replace Event Recorder Unit"

Supplies
Crash Hardened Memory Module Assembly, 54540-01

Consumable(s)
Cabile ties, 43353-2B
Cable ties, 43353-7

NOTE

Event recorder components are sensitive to static electricity.
Use wrist grounding strap to avoid damage from electrostatic
discharge.

NOTE

Crash Hardened Memory Module Assembly (CHMM) is
non-repairable and must be replaced if faulty.

Replace Crash Hardened Memory Module (CHMM)
1. Remove ten screws, lockwashers, and flat washers securing front cover to ERU. Discard lockwashers.
2. Remove four cap nuts (1) and lockwashers (2) securing CHMM (3) to left side of ERU.

3. Remove cable (4) between CHMM and board stack by removing screw (5) securing cable ties on cable and
disconnect cable from the board stack.

4. Cut and discard any cable ties securing cable to retaining bar.

WARNING

CHMM weighs approximately 10 Ib. Exercise care when
removing from ERU to avoid injury or equipment damage.
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BAC7614

Figure 13-17 CHMM Replacement
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5. Install new CHMM (3) and secure to side of recorder with cap nuts (1) and new lockwashers (2).

6. Re-connect CHMM cable (4) to board stack, and secure using new cable ties (43353-2B on retaining bar and
43353-7 on board).

7. Secure ERU cover with ten screws, new lockwashers, and flat washers.

END OF PROCEDURE
Follow-on Tasks
Test ERU using the Bench Test Equipment (BTE). For instructions for the BTE, refer to Bench Test Equipment
(BTE) Maintenance Manual 934-BSC-0411 in System 16, Reference Documents / Special Gauges and Tools.
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13.9.3  Overhaul RTC PCB Assembly

Applicable Car(s): B-Car

Equipment Condition(s)
Event Recorder Unit (ERU) removed from car.
Refer to 13.9.1 "Replace Event Recorder Unit"

Test Equipment
Multimeter

Supplies
Battery, Lithium LTC-7P, LTC-7P LITHIUM

Consumable(s)
Cable tie, 43353-2B
Blue Loctite, #425

NOTE

Event recorder components are sensitive to static electricity.
Use wrist grounding strap to avoid damage from electrostatic
discharge.

Replace Battery on Real-Time Clock (RTC) PCB Assembly

1.
2.

= © ® N o o k&

Remove ten screws, lockwashers, and flat washers securing front cover to ERU. Discard lockwashers.

Remove five screws (1) and lockwashers (2) securing board stack (3) to right side of event recorder. Extract
board stack and discard lockwashers.

Remove cable (5) between CHMM and board stack by removing screw (4) that secures cable tie and
disconnecting cable from board.

Remove four nuts (6) securing Dual Ethernet board (7) to RTC board (9).

Remove four standoffs (8) securing RTC board to Single Board Computer (SBC).

Cut cable tie (10) securing battery (11) to RTC board (while noting its position). Discard battery and cable tie.
Using multimeter, confirm output of new battery is greater than 3.65V.

Insert new battery securely onto terminals and secure with new cable tie. Trim cable tie to length.

Secure RTC board (9) to SBC board with four standoffs (8).

. Secure Dual Ethernet (7) board to RTC (9) board with four nuts (6). Apply loctite to nuts securing top board to

standoffs.

. Replace cable (5) between CHMM and board stack and secure with screw (4) and new cable tie.
12.
13.
14.

Return board stack (3) to right side of ERU and secure with five screws (1) and new lockwashers (2).
Secure front cover of ERU with ten screws, new lockwashers, and flat washers.
Reset ERU clock time.
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Figure 13-18 Real-Time Battery Replacement (Sheet 1 of 2)
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Figure 13-19 Real-Time Clock Battery Replacement (Sheet 2 of 2)
END OF PROCEDURE

Follow-on Tasks
Test ERU using the BTE. For instructions for the BTE, refer to Bench Test Equipment (BTE) Maintenance Manual
934-BSC-0411 in System 16, Reference Documents / Special Gauges and Tools.
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13.9.4 Overhaul SBC PCB Assembly

Applicable Car(s): B Car

Remove Event Recorder from Train

1. Follow the instructions outlined in the BS1990 Rev A SNC63010 Programming Instruction manual in System 16,
Reference Documents / Special Gauges and Tools

END OF PROCEDURE
Follow-on Tasks
Test event recorder for proper operation. 13.7.2 "Test Event Recorder Unit"
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13.10REFERENCES

Referenced Procedures
This System does not contain references.
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Overview

The Event Recorder Manager {(ERM) application interfaces with Bach-Simpscn 63000 series event
recorders to allow access to data retrieval and management functions. Communications to the
event recorder is via TCP/IP connections using ports 80 and 42010.

With the ERM you can:

¢ View the current values of data being recorded by the event recorder.
e View the current status of the recorder.

¢ Retrieve recorded data from the recorder.
L

Perform various recorder maintenance functions on the recorder like setting the clock or
retrieving the maintenance log.

The ERM is very flexible in the way it performs these functions. It allows the user(s) to:

¢ Design the layout and content of the views used to access the recorder's data or control
functions.

¢ Set up security for access to data and management functions.

The ERM application is a viewer that displays user-defined views of the event recorder data and
functions. Each user may require a different set of views for their particular application. The ERM
also allows users to edit these views, and places security restrictions on the views and the
components that make up the views.
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Getting Started

If you are setting up the Event Recorder Manager (ERM) for the very first time, you will be
prompted for the provided customization package. This package will define all of your views.

If did not receive a customization package, the ERM will prompt you to set up access control to
the controls that make up the views. The ERM will ask you if you want to set up View Control
Access. If you select Yes, it will bring up the View Control Security dialog. Refer to View Security &
Protection for more information. This task should be performed by semeone who will be
responsible for managing access to the event recorder and its data.

If you did not receive a customization package with the ERM distribution, you will not have any
Views defined. Views describe the way event recorder data is displayed, and the functions that
can be performed on the recorder. Refer to View Management for more information.

-0~
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Views and Viewer Model

To allow for flexibility and maintainability, the Event Recorder Manager (ERM) application
separates the interfacing to the event recorder and the display of data. The ERM contains nothing
specific to the event recorder or the customer application. It retrieves the event recorder
configuration when it first connects to the event recorder. Once connected, it determines the
customer application by reading the Application ID from the event recorder. After the Application
ID is established, the ERM looks in the appropriate directory for the files containing the view
definitions for that customer application. Thus, if a customer had several different event recorder
configurations, or applications, a single ERM could be used for all of them. This also makes event
recorder updates seamless because the ERM can support a fleet with different versions of event
recorders installed so that updates can be rolled out in phases.

The ERM could be thought of as simply a viewer application that runs and displays the views
selected by the user. A view consists of any number of "view controls” that can perform various
functions like displaying data or starting a data download. Users define views by adding view
contrels to a view.

Using the ERM can be roughly broken into 3 main areas:
1. Managing the Views

2. Securing the Views and View Controls

3. Using the Views (interfacing to the event recorder).

Once the system is set up, most users will spend the bulk of the time in area 3, interfacing with
the event recorder.
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View Management

View Management consists of creating and maintaining view definitions. Views are created and
edited from the View menu with the Create.. or Edit... option, respectively. The editing dialog is

el Edit View

Name !Dnnr Status R |

| Layout l LeftToRight

Description |.-'1\II Doar related parameters ‘

Fonts :
[_ Yalues ] [ Invalid ‘;«-*‘a1ue ]
Sizes [Pixals) :
Labels l15ﬂ Bl Yalues
. "\I]EW Items . . . e e W..,._ - s e et .

These controls will display data in the view: [ f'ﬁ'dd ] [ Remove ] A

Comta | Ehannel
L v Dm,]:meT;L[L] v
”Bn:.u.-:éa"-!alun; . .“.Vi Door Close TAL [R] vy
BoxedValue v Door Enable Bypass Switch 1 e
-| BowedValue V Door Enable Bypass Switch 2 i*"i
BoxedValue +'| Door Enable B vpass Switch 3 ad
Boued Value v Doar Enabla/Unlock T/L (L) v
BoxedValle . | Door EnableAdnlock T/L [R) vy
Bosed Value | Doar Interlock Bypass Switch s
. Security
Members of lEVBf}'D"e —"fll can see this view.

Members of | BACHSIMPSONAD omain Users | can et this view

Cancel

NOTE: The Event Recorder Manager (ERM) must be connected to an event recorder configured for
the customer application you wish to define views for. This is where the ERM gets the list of
channels and other information from.

Fields and functions:

Name: Every view must have a name. This name is used to identify the view when selecting it in
the ERM, and is also used to create the file where the view definition is stored. For this reason
characters that would not be valid in a file name are rejected. Names within a customer
application should be unigue.

Layout: This affects how the individual view controls are placed in the view pane.

Wrap: When checked, the view pane will wrap the list of controls around to best fit the available
visible area. If all the controls can not be fit into the visible area, then scroll bars will be shown
allow the hidden controls to be scrolled into view.

Description: Allows descriptive text or instructions to be added to the view that will be shown at
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the top of the view pane when the view is showing.

Fonts: This group of buttons allows you to select the fonts used to display values. The Labels
font affects value labels, the rest affect the displayed values, The Values font is used for valid
values within their expected range. The Invalid font is used when displaying values that are not
validated as correct, due to some failure. The Out of Range font is used to display values that
are outside of their configured range.

Sizes: The setting in this group determine how wide the labels and values will be when displayed.
When applied to a Boxed Value control, the label width is the width of the whole control and the
Value width should be less than the label width for best results.

View Items: This group selects the controls and order they appear on the view. In the Control
column, the type of control is selected. If the control can be attached to data from the recorder,
a list of appropriate channels will appear in the Channel column. Note that the view cannot be
saved until all the controls that need channels have been assigned channels. The up and down
arrows can be used to rearrange items,

Security: The security group allows you to select which Windows User Groups will have viewing
and editing access to the view. See View Security & Protection for more information.

Update: this button commits the changes, or creates a new view in create mode.

Cancel: discards any changes, but prompts to be sure.

View Files

Each view definition is stored in a file with the same name as the view and an ermv extension.
They are stored in a common application directory where other users can see them, in a
subdirectory for the customer application. Each customer application has its own subdirectory.
Once defined, view files can be sent to other computers. Deleting a view, deletes the view
definition file. You can back up your views by making a copy of the application subdirectory.

View Controls

The types of controls available for inclusion when editing is controlled by the View Security &
Protection settings.

Refer to View Controls for a list of possible View Controls and their description,

_0..
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View Security & Protection

The Event Recorder Manager (ERM) application allows access to all event recorder management
functions, including software installs, clock setting, and maintenance log erasure. It may be
required to restrict access to some of these functions to selected groups of users.

Integrated Security

The ERM uses a flexible security mode! that leverages the native security built into Windows.
There are two levels of security in the ERM: View Level and View Controf Level. View Level
security controls access to entire view. View Control Level controls access to the individual
controls that make up a view. Each level of security has two types of security: View and Edit. View
type security controls who can view the View or View Control. Edit type security controls who can
edit a View or place a View Control on a View.

User Groups

All levels and types of security use Windows User Group membership to control access. This
means that the administrator of the computer would set up Windows User Groups for ERM access,
for example an "ERM Administrators" group, an "ERM Service" group and an "ERM Maintenance"
group. Then individual users could be made members of one or more groups to control their
access. User access to the event recorder can then be contrelled using standard IT policies.
Windows security can be adjusted to require strong passwords, biometric login (i.e. thumb print),
and/or hardware key. Thus, the same policies that protect the computer and data are used to
protect access to the event recorder.

View Level Security

Consider a view that allows & user to update the software on an event recorder. Only members of
the "ERM Service" group should be able to see this view and only "ERM Administrators" should be
able to edit the view. Note that the administrator should be a member of all groups accessing the

ERM.

In this scenario, the View's view security would be "ERM Service" and the edit security would be
"ERM Administrator".

View Control Level Security

. Yiew Control Security

The access to individual control t

ji Control

Bemd va |ue I

| View Group

| Edit Group

Everyone

.| Evenmone

Everyane

.| Everyone

Clack Set

BUILTINPower Users

1 BUILTINNAOministrators S ;

Computer Time Set

BUILTIN Power Users

4 BUILTIN“Administrators -

Calibrate Channel

BUILTINA\Powrer Users

"t BUILTINSAdministrators

| Log View

Everyone

4 BUILTINAdministraters

i Log Erase

BUILTINYPower Users

1 BUILTIM & dmiristrakors

Data Download

BUILTINNPawer Users

1 BUILTINSAdministrators -

I Self Test

BUILTINSPawer Users

< ¢ sl <l<leie]

i} BUILTIMYAdministrators v

PRI ST TN

FERTTEE 3 AT W

Managing Group

pes is controlled via the View Control Security dialog:

BUILTIM\Administratars

gv-l I VUp_clate | [ Cancel ]

It this dialog, all the View Controls supported by the ERM are listed in the Control column, The

Version 2.0 Oct 2008 page 9



Bach-Simpson Corp. - Software User Manual for Event Recorder Manager - CM63166

other two columns allow you to set who has viewing and editing access to this type of control,

respectively. The Managing Group drop-down sets the user group who manages these
permissions.

Consider a View that contains two controls; a maintenance Log View control and a maintenance
Log Erase control. When the system was initially set up, the Log View control is viewable by
"Everyone" but only "BUILTIN\Administrators" are allowed to place the control on a view (Edit
Group). The Log Erase control is only viewable by members of the "BUILTIN\Power Users" group,
and again only "BUILTINVAdministrators" can put the control on the view. If a user was only a
member of the "Everyone" group access the view, then they would see only the Log View control,

but if a user was a member of both "Everyone” and "BUILTIN\Power Users", then they would see
both controls.
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Viewing Interface

The Event Recorder Manager's (ERM} viewing interface consists of 4 main areas:
1. The menu at the top,

2. The view control bar in second line,

3. The view display area in the middle, and

4, The status bar at the bottom.

These three areas can be seen in the image below:

7. Event Recorder Management

: "'ew Contol Secunty He!p

[ < F‘rewnus ] [ Next > ] View: | vl Current sensor valuss
| Brake Pipe Prezsure ~ Brake Cylinder Pressure Horn Activated - o
-160.0 (psi) ' -45.0 (psi} -
Headlight On Speed - ATC Time (L] B

2008-02-13 17:10:54.0 | Connected | Application: "PAS" | Version: 1,12 | Car #: 0 | Serial: "6-1132" | Recording |

NOTE: The ERM uses the format for dates an times specified by the event recorder's
configuration. You can examine these format strings in the Configuration display.
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Main Menu

The main menu contains four options which cover the following functional areas:

IMenu Item |[Functions

|Fi|e ||Connecting to the recorder, creating reports.

|View ||View appearance, View manadgement, View rotation control

View Control ||Manages the access to View Controls. Not visible if current user does not have
Security access.

[Help llProduct info, user guide.,
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File
The File menu allows you to:

e Enter the address of the event recorder you wish to interface with, via the Recorder
Address... option.

Note 1: The ERM software will remember the last event recorder it was connected to.
Note 2: If multiple addresses were specified on the command line, the Name drop down will
allow you to select from those addresses.

Connect to an event recorder.
Reload the configuration from the event recorder {e.g. after installing new system software).

Generate a Data Report suitable for printing or exporting. A data report is a tabular summary
of the data being recorded at the time of the report. There is an option to include only the data
in the current view or all data.

e Generate a Maintenance Log Report, suitable for printing or exporting, containing the current
contents of the maintenance log.

¢ The Recorder Configuration option displays a hierarchical view of the recorder's
configuration in an expandable tree structure. This is useful for looking up calibration factors,
data interpretation mappings, and other details.

e Exit will exit the program.

Version 2.0 Oct 2008 page 13



Bach-Simpson Corp. - Software User Manual for Event Recorder Manager - CM63166

View
The top four sections of the View menu control how data is displayed. The fifth section is for view
management, and the sixth section modifies the View rotation list.

Display Values & Units

The top section controls the conversion factors and units of measure. Engineering units are the
normal way to view the quantities being recorded. Electrical units are the internally calibrated
values, before conversion to Engineering units. Raw units are the data as received in their native
form.

Names

The channels of recorded data can be referred to by different names. The second section of this
menu selects the names used for labels,

Value Interpretation

Some encoded values have special meanings and the Interpret menu option allow the values to
be interpreted into their textual representations.

Time Representation

The event recorder uses universal time (UTC) internally, and this is the default way to look at
data. For some users it may be more convenient to adjust all times shown for the local time
offset. Checking the Show Local Time shifts all times shown by the UTC to local offset. If some
input channels to the recorder are NOT in UTC they will be adjusted as well since the recorder
assumes all times are UTC, and may not appear as expected.

View Management

This section allows for the creation, editing and deletion of view definitions. See View Management
for more information.

View Rotation Control

To simplify access via keyboard, the Event Recorder Manager maintains a list of most recently
viewed views. Every time a view is explicitly selected from the View drop-down, that view is
placed at the head of the most recently used rotation. The rotation is navigated via the Previous
and Next buttons. If you would like to remove the current view from the rotation, select the Skip
option in the View menu. If you would like to clear the rotation list entirely, select the Clear
rotation option.
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View Control Security

The View Control Security is only visible if the user is a member of the View Control Security
Management group.

This menu option brings up the View Control Security Dialog. See View Security & Protection for
more information.
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Help

The Help menu provides access to:

e User Guide: displays this context sensitive help file.
* About ...: Software information including version.

=0~
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View Control Bar

To simplify keyboard access, the Event Recorder Manager (ERM) maintains a most recently used
list of views. The user can rotate through this list to quickly access commonly used views. The
rotation can be cleared and views can be removed from the rotation. The rotation list is saved
when the program is closed and reloaded on start up. Whenever a view is selected directly from
the View drop-down, it becomes the most recently used and is inserted in the rotation.

The View Control Bar consist of 4 controls:

1. The Previous bution displays the previous view in the view rotation. At the end of the list it
wraps around to the most recently used.

2. The Next button displays the next view in the rotation. At the end of the list, it wraps around
to the least recently used view.

3. The View drop-down list allows random access to all the available views. The list is sorted by
name. You can scroll through the list to find a particular view of interest, or start typing the
name of the view for quicker searching. Once a view Is selected, it becomes the most recently
used view and is inserted at the head of the rotation list.

4. The Description field contains information that the view creator supplied and may contain
information on how to interpret or use the current view.

To facilitate keyboard navigation, if either the Previous or Next buttons have focus, then the
Page Up and Page Down keys will also move forward or backward through the view rotation,
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View Display Area

The view display area presents the view indicated in the view control bar above it, The controls on
the view will be laid out according to the way the view was defined. If all the view controls can not
fit in the visible area, scroll bars will appear. The main window can be resized and the view will
reconfigure itself if necessary based on the layout and wrap settings.

Any View Controls that the current user does not have access to will not be shown.

=0~
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Status Bar

The status bar contains the following information and is continually updated:
5. The real-time clock value the recorder is using.

6. State of the connection to the event recorder.

7. Customer application ID. This value is used to select the views displayed.
8. Software version of the event recorder.

9. Car number/ID.

10. The serial number of the event recorder.

11. The current recording state.

12. A faults indication
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View Controls

Every View is a collection of View Controls. Scme controls display data from the event recorder,
and some execute functions on the recorder, and some are combinations of displaying data and
executing functions.

Views can be designed for any task or purpose by placing the appropriate controls in it. The Event
Recorder Manager supports the following View Controls:

View Control Purpose or Function

Type
|Boxed Value ||Disp|ays a selected data channel's value in a box labeled by the channel name. l
|Ciock Set ||Uses a recorder input channel as source to set the recorder's internal clock. |

Computer Time |[[Uses the ERM's clock to set the event recorder’s internal clock
Set

|Data Download ”A control that allow the selection and retrieval of the recorder's event data.

|
|Log Erase ||A control that allows the maintenance log to be erased. |
|Log View ||Shows the contents of the maintenance log, and allows it to be saved to a file. |
|Name Value Pair ||Shows a selected channel's data as a label followed by a value. |
|Se|f Test ||A control that initiates the recorder's self test function and displays the result. |
|Separator ||A visual deliminator to demark and organize View layouts. |

|

|Software Upload ||Instaiis new system software on the event recorder.

-0-

Version 2.0 Oct 2008 page 20




Bach-Simpson Corp. - Software User Manual for Event Recorder Manager - CM63166

Boxed Value Control

The Boxed Value control displays the current value of a selected channel, The name of the channel
is the title of the box. A example is shown below;

Brake Pipe Pressure Brake Cylinder Pressuse
-1.6 (psi) 1.3 (psi)
Speed ATC Tim.e.[L]
0 (mph) ‘ 2008-10-07 13:23:19

The above image shows four Boxed Vaiue controls as they may appear in a view.

If the mouse cursor is hovered over the title, details of the channel are displayed. If the mouse
cursor is hovered over the value, value details are displayed.

=-0-
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Clock Set Control

The Clock Set Control allows an input channel to be used to initialize the event recorder's internal
clock. A Clock Set Control may look like the following:

[SystemUicTime 19691231 19:00:00
Real Time Clock 10-14-2008 10:14:47
IGPSValidity Invakd

Pressing the Set button sets the recorder's clock to the displayed value.

Note: the event recorder uses universal time (UTC). Input channels are not corrected for the time
zone of the source. The time shown is affected by the setting of the menu item Show Local
Time, but the value sent to the event recorder is not affected by this setting.

Warning: Setting the internal clock can make some data inaccessible if times overlap. Avoid
seiting the clock backwards when recording.

Setting the clock will create an event in the maintenance log.

-0-
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Computer Time Set Control

The Computer Time Set controi ailows the event recorder's internal clock to be set to the time of
ERM computer. A Computer Clock Set Control may look like the following:
Computer Time 2008-021519:40:409 [ et |

Clicking the Set button initializes the event recorder's internal clock to the time of the computer
running the Event Recorder Manager.

Note: The time shown is affected by the setting of the menu item Show Local Time, but the
value sent to the event recorder is always universal time (UTC).

Warning: Setting the internal clock can make some data inaccessible if times overlap. Avoid
setting the clock backwards when recording.

Setting the clock will create an event in the maintenance log.

O
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Data Download Control

The Data Download Control allows event log data to be retrieved from the event recorder. The
Data Download Control appears as below:

Event Data Download

Pericd
From: | 2008-02-13 21:49:04 v
To: | 20080215 21:49:04 vl

Duration: E___:_I Days [P % | Hours
Destination;

PAS_0_1203112144er_ |

The Data Download Control allows for a flexible specification of the data to be extracted from the
recorder. The limits of data can be specified as a start and end time in the From and To
date/time selectors, or as an duration prior the To time. Editing one field updates any affected
fields to maintain consistency. The To time is limited to the last available time on the recorder,
and the refresh button will update it.

The destination folder and name can be specified via the Browse button. The Event Recorder
Manager will remember where you last specified the download directory and use it as the default.
The Download control generates a suggested filename based on the application ID, car number,
and To time. It can be overridden in the file save dialog brought up by the Browse button, or
edited directly. It is not recommended to change the file extension from "er", since this is used to
identify this type of file to other applications.

Once the Download bution is pressed, the download will begin and a progress dialog will be
shown. The data will be downloaded to the file specified above,

-0~

Version 2.0 Oct 2008 page 24



Bach-Simpson Corp. - Software User Manual for Event Recorder Manager - CMB83166

Log Erase Control

The Log Erase Control allows the maintenance log to be cleared. The control appears as below:

| Erase Mainienance Log |

Clicking the Erase Maintenance Log will reset the maintenance log on the event recorder. Note
that the new log file will contain a record of the erasure.

Erasing the log will create an event in the maintenance log.

-0-
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Log View Control

The Log View Control displays the contents of the event recorder's maintenance log. It will appear
similar to below:

Maintenance log loaded at 2008-02-19 09:48:06 Refresh ] [ ToFile ] [ Fram File
No. i Time [U'TE}”  1Sev. :Code  Car Description t User
503|20071207221553{7  |HELLOI | |Recorder PoweredUp-
504 | 20071207 221611172 HELLO! Recorder Powered Up
C505[200712.07221623|7  |HELLO! | | Recorder PoweredUp
506 | 2007-12-07 22:16:36 | ? HELLO! Recoider Powered Up
507 | 20071207 2216:48 | 7 HELLO! | Recorder Powered Up |
506 | 2007-12-10 15:44:36 | ? CALIBR Calibrated Channel #191 | 510088832

The table in the log view shows the following information:
|Column [[Contents |

No. The event number. This number increases for every event. It will be 0 for SCI failures
since the previous number cannot be determined.

|Time I[The value of the event recorder's internal clock when the event occurred. —|

[sSev.  ||A severity code. |

|Code ”An event code for the type of the event. Defined by the event recorder software. —|

|Car ||The car number at the time of the event. |

Descripti||An event recorder defined description of the event.

on

User For operations that require authentication, the user identifier of the user performing the

operation.

The following functions can be performed with maintenance log data:

Refresh updates the log data shown with the most current data from the recorder.
To File saves the log data to a comma separated value (CSV) text file with headers,
From File loads the log view with data from a previously saved file.

Note that a printed report of the maintenance log can be obtained from the File menu.

-0-
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Name Value Pair Control

The Name Value Control displays a channel name followed by a channel value, and may appear

similar to below:

ATC Speed Limit [L] 0.0 [rpk)

If the mouse cursor is hovered over the title, details of the channel are displayed, If the mouse
cursor is hovered over the value, value detalls are displayed.

-0-
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Self Test Control

The Self Test Control initiates a self test of the event recorder, and displays the result. The control
appears as follows:

, Run Self Test | PASSED 20080219 11:12:34
The result is updated shortly after the Run Self Test button is pressed.

Running a self test will create an event in the maintenance log.

=-0-
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Separator Control

The Separator control appears as a thick line on a View. For TopDown and BottomUp layouts, it is
a horizontal line. For LeftToRight and RightToleft layouts, it is a vertical line.

=0-
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Software Upload Control

The Software Upload Control install new system software on the event recorder, replacing the
system that is currently running. The control may look like the following:

Available: |1.12 ;v] [ Browse ... ] [ Upload ]
The Available drop-down lists all the files with a .tgz extension in the directory specified in the

Browse... button. The Event Recorder Manager {ERM) remembers where the last software was
uploaded from and that becomes the default upload directory.

The Upload button will upload and install the software selected in the drop-down. Once on the
recorder, the recorder validates the file and then install it. After the install, the event recorder will
reboot to run the new version. During the reboot, the ERM will be disconnected. After
reconnecting, it may be necessary to reload the configuration from the recorder.

Installing new software will create an event in the maintenance log.

-0
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Application Authorization

The ERM Is capable of communlicating with any Bach-Simpson 63000 series event recorders.
Event recorders are custom configured for a specific customer application. Some of the functions
provided by the ERM can alter the function of the recorder, for example setting the clock. For this
reason, each application has a unique authorization key so that it will only accept such commands
from authorized ERM clients.

Application authorization keys are part of the ERM license file (ERM.license) that is used to unlock
the ERM application. It may be possible that your fleet consists or more than one application, or
version of event recorder. The ERM license file can contain several application authorizations for
such configurations. The About box lists all the applications that are enabled by your license. If
you should ever get a failure notice on a command to the event recorder, you can check to see if
your license authorizes you to make alterations for that application by checking in the About box,

-0-
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Managing Multiple Systems

Once you have configured the views and security for the Event Recorder Manager (ERM), it may
be necessary to distribute the configuration to several other computers. To distribute the settings,
two components need to be deployed: the registry settings for the View Control Access, and the
view definition files. To create the registry settings file, use RegEdit to navigate to
HKEY_LOCAL_MACHINE\SOFTWARE\Bach-Simpson Corporation\ERM and right click the node to
bring up the context menu. Then select Export.

# Repistry Editor

File Edt View Favorites Help

@] AT A| Mame _
@-{£7) ATI Technologies E’:](Default]lM T

&] ] -ATI Technologies Inc, Vi ewControlHash
&] Autodesk . ||| [@B]viewControlManager
@-{7 Avery Dennison N

-2 Axialis -

&-[7 Axis Communications
&ZICZI Bach-Simpson Corporation
L e-EaE
. L.[7) viewControlbccess
. -3 Event Recorder
L{Z] BlenderFoundation
&7 Boilsoft
#-£7 BreakPoint
53] Co7ftsy
3-(23) callas software gmbh
: £1-27 Chilkat Software, Inc. ™
Lo T T e ) B

My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Bach-Simpson CorporationiERM .

This will allow you to save the node to a .reg file. If you distribute this file, recipients can double
click it to import it inteo their registry. Or use the File... -> Import option.

To distribute one or more View definitions, you need only to distribute the .ermv files and place
them in the customer application folder. These files reside under

% ALLUSERSPROFILE% \Application Data\Bach-Simpson Corporation\ERM. There will be
a subdirectory for each event recorder configuration.

-0~
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Command Line

A list of Event Recorder and their addresses can be specified on the command line to simplify
connection to multiple recorders at different addresses. The ERM command line supports the
following syntax:

ERM [addri[#namel]] [addr2[#name2]]...

Where:
addrl is the first event recorder address
namel is the oplional name of the first event recorder
addr2 is the address of the second recorder
name2 is the name of the second recorder.
... etc.

All parameters are optional. The ERM will display the address and a list of recorder names in the
Event Recorder Address dialog. The address can be set by selecting the appropriate name from
the list of names.

If any addresses are specified on the command line, the first address becomes the address the
ERM attempts to connect to.
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-l Edit Bookmiark v _ ol x
[

Time: 2009-05-27 14:03:35.0

Name: ITEStiﬂg
Diescription:
Testing

Ok Cancel |

4

Enter a name for the bookmark.

Enter a description for the bookmark.

Click ‘OK’ button.

The bookmark is now created. If the user forgets to save the bookmark, the Data
Analysis program will remind them to save bookmarks before exiting the program.

ook w

ILLUSTRATION 39 — LOAD BOOKMARK

7. Click ‘Bookmarks’, navigate to ‘Load Bookmarks’ menu item
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open 20

Look i IDBach—Simpson DAS Views ﬂ Qo Er

[=|M8_9103_4294967295.erbm

Deskiop

o

My Documents

File name ﬂ Open
Files of type: IEventBookmarkﬁles (*.erbm} LI Cancel

8. Choose name and location to load the Bookmark file from.
9. Bookmarks are now load from disk.

raxSyte 1 2l-1o]x|
Controllers  Help
— (o]
Views | Bookmarks | Time Offset ... Export... Phayback.. Help
Load Bookmarks ...
ay <HT [ <Mmn G e in > |Hr>| Day > [
1/81338 2010-01-12 09-05-2; 6.0 |
x|

9-05-2, 36.0
2009-05-27 14:03:36.8
6.0

2009-05-27 14:03:40.0 |
2009-05-27 14:03:41.0
2009-05-27 14:03:42.0
2008-05-27 14.03:57.0
2009-05-27 15:31:20.0
4

M8_9103_4294967295.er GraphView.
View Channels Chart Options  Help

200

150

100

50
BrakePipe (psi)
194.5(194 513)
2009-05-27 1419:28.6 0

-50

-100

-150

140500 1470:00 14:15:00 14:2000 142500 143000 143500 14:40:00 14:4500 1450:00 145500 15:00:00

ILLUSTRATION 40 — SAVE BOOKMARKS

1. Click ‘Bookmarks’, navigate to ‘Save Bookmarks’ menu item
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20x|

Save in ID Bach-Simpson DAS Views ﬂ & my

(5] M8_2103_4294967295.erbm

fy Recent
Documents

Des_lv_dgp

L

My Documents

s

My Computer

9
My Network
Places

Save

Cancel |

A

File name M 8_9103_4294967295 erbm)

EANEN

Save astype: IEventEcukmarkﬁ\es (*.erbm}

2. Choose name and location to save the bookmark file to.
3. Bookmark file is now saved to disk.

4.7. Time Correction

The Event Recorder maintains an internal time reference based on UTC that is not automatically
synchronized to any other system times (for example, car network). There are two separate ways
to configure TraxSyte to adjust the Event Recorder’s internal time reference based on user
needs. These time corrections are applied to the Event Recorder’s internal time reference only,
not to any recorded time signal.

4.7.1. TIME ZONE OFFSET

The purpose of this function is to allow the user to offset times from UTC to a different time zone
for all Event Data log files. Time zone settings are a range from -12 hours to +12 hours. This
setting is remembered across starts of the application so the user does not have to remember to
adjust this setting every time TraxSyte is run.

TraxSyte

Controllers | Date Format — Help

st [ =l
Wi Hide Expott... Playback... Help
Tirne: ‘ :::1::”& EaT— ‘ arks: |<none> v ﬂl
I;I | LA LN | Secy Min » Hr > Day > ;\I
2010-12-08 17:30:21.2 14108375 2011-02-07 18:12:00.3
il =]
Suibfile: |1 - 2010-12-08 21:30:21.2 to 2011-02-07 2212:00.3 j

ILLUSTRATION 41 — TIME OFFSET

1. From the TraxSyte menu click the ‘Controllers’ -> ‘Time Zone Setting’ menu item
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£ Time Zone Offset iy ] 4

Select an offzet from UTC to be applied to all displayed timestamps:

Hours

o« =
Set Cancel |

4

2. Select the appropriate number of hours to offset the time zone by and click Set.

4.7.2. TIME ADJUSTMENT

Time Adjustment allows the user to change the reference time on a specific Master Controller so
that the Event Data file is synchronized with another time reference. This time reference could be
a recorded time signal such as the ISystemUtcTime from the TCMS.

RI=E]
Wiews  Bookmarks Export ... Playback ... Help
Time: | EERH-12-08 17:30:21 | Bookmarks: I <hones - l ﬂl
LI <Day| < Hr | <Min| <Sec:| Sec | Min>| Hr > | Da_l,l>| >||
2010-12-08 17:30:21.2 14108975 2011-02-07 18:12:00.3
Al =
Sub-file: |1 - 2010-12-08 21:30:21.2 ko 2011-02-07 22:12:00.3 j

1. From the Master Controller menu click ‘Time Adjustment’.

Days Hours  Min Sec.

Jo =l = = 4

Set | Cancel |

2. Enter the time adjustment required.
3. Click ‘Set’ to change the Master Controller’s time reference.

4.8. Exporting Data

The export option allows the user the export all or specified channels in Engineering, Electrical, or
Raw units to an external file format. Formats available are Comma, period, space and Tab
delimited data.
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raxSyte i =1 E3]

Fie Controllers Help

Views Bookmarks  Time Offset ... Playback .. Hep

Time:[2009-05-27 140335 =] Bookmarkq Testing =[oe
1< | <Day <tir | <Min <Sec Sec> [Min> [Hr> | Day> i
20090527 1181338 2010-01-12
(al =

View Channels  Chart Options  Hep
200

150

100

50

BrakePipe (psi)
194.5(194.513)
20090527 14:1928.6 0

-50

140500 141000 14:1500 142000 142500 14:30:00 143500 144000 14:4500 1450:00 14:55:00 15:00:00

ILLUSTRATION 42 — EXPORTING EVENT RECORDER DATA

1. Click the ‘Export’ menu item
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wn

No ok

End |2D1‘I-D2-D?18:12:DD

— Export Units

" Raw " Electrical % Engineering

— Export Interpreted Values
1 Ag numbers % figs best

File: Browse .. |

Field Delimiter: I vl

Channeks: Selectal | Clearan |

[w] &AC Mode

[w] ACSES 1 Civil Speed

[w] ACSES 2 Alarm TOD

[w] &CSES 3 Poz Stop Req

[w] ACSES 4 Penalty Brake

[w| ACSES B Poz Stop Overide
[w] ACSES 7 Poz Stop Radio Override
[w] ACSES 8 Tranzsponder Code
[wl ACSES Timeout

[wl| Alerter Penaly Brake

[w] A1 Faults

-

=

Cancel |

Set the Start time and End Time of the data to export.
Set Export Units to Raw, Electrical, or Engineering. For Exports generated from Tabular
Views this setting will default to the value used on the Tabular View.

Set Export Interpreted values to either numbers or text.
Click ‘Browse’ button to choose a filename and location of the exported data.

Click on ‘Field Delimiter’ pull down menu to choose the data delimiter required.

Click on ‘Select All' to select all channels to export or ‘Clear All’ to clear all channels and

then choose channels individually. For Exports generated from Tabular Views the

channel selection will default to the channels selected in the Tabular View.

8. Click on ‘Export’ button to start the export process.
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Esport x|

Stant |2010-1208 17:30:21 =
End |2011-0207 12:12:00 =
— Export Whits

) Faw " Electical ¥ Enginesing

i Export Interpreted Yalues
' Az numbers Lo

File: Brawse ... |

[E:\Cogs\M8_3109_2011-02-07T22-11-37.csv

Field Drelimiter: I VI

Chanrls: Selectal | | mearsl |

[w] AC Mode ﬂ
[l ACSES 1 Ciwil Speed

[l ACSES 2 Alarm TOD

[w] ACSES 3 Pos Stop Req

[w] ACSES 4 Penalty Brake

[w] ACSES 6 Pos Stop Ovemnide

[l ACSES 7 Pos Stop Radio Overide

[w] ACSES 8 Tranzponder Code

[l ACSES Tirmeout

[w] Alerter Penalty Brake

il M1 Faults |

Ewport | Exporting... Cancel

9. The data will now be exported with the progress bar displayed at the bottom of the
window. Clicking Cancel will terminate the export process. When the export process has
completed a dialog will appear.

Export Complete x|
Ll
\]‘) Export completed successfully,
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4.9. Data Playback

The Data Analysis Software has the ability to let the user playback the Event Recorder data at
various speeds. During playback the different views will change as data is analyzed.

7\ Traxsyte
Fie Controlers Hep

03_4294967295.er i
Views Bookmarks  Time Offset ... Export ... Help View Chanoek. Export.. Dephy  Heb
Time:[AWE 0527 140431 = Bookmrkd <none> =] Add Speed  |CabActA |CabActB [MCPosA
< | <Day <Hr | <Min <Sec Sec> [Min> [Hr> | Day> i
20090527 12/61338 201001-12
< 2l

2715:31:214
271531215 |

Channels ~ Chart Options  Help.
200

150

BrakePipe (psi)
1945 (194 513)
20090527 1419286

-150
140500 141000 141500 142000 142500 143000 143500 144000 144500 145000 145500 150000

ILLUSTRATION 43 — DATA PLAYBACK

1. Click ‘Playback’ menu item

x|
Ll Stop |L|

Speed:

2. Choose which speed to playback data at. Click on Pull down speed menu to choose
speed.

To play data forward in time, click on ‘>’ button.

To play data backward in time, click on ‘<’ button.

To stop play back, click ‘Stop’ button.

arw
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4.10. Master Controller Help

Traxsyte

Fle Controlers Help
M8_9103_4294967295.er

Views Bookmarks Tme Offsct ... Bxport... Payback Ve Chnde Exiort

Time:[BUEE-05-27 14:05:07 = Bookmarkd <none> | Add

I= | <Day <HT| <Min <Sec Sec> |M>n> |Hr>| Day> | 2009-05-27 14:03:57.0
2009-05-27 12/81338 2010-01-12 )09-05-27 15:31:20.0
[l |

M8_9103 4294967295.er(§laph\rﬂw
View Channels  Chart Options  Help

200

150

100

BrakePipe (psi)
194.5(1%.513)
2009-05-27 14:19.28.6

141000 141500 142000 142500 143000 14:3500 144000 144500 14:50:00 145500 1500:00 15:05:00

ILLUSTRATION 44 — MASTER CONTROLLER HELP

1. Click ‘Help’ menu item

=T

o v
Hide Baclk  Fomwsd  Prnt  Options

[2] Definitions and Termine ||| The Master Control panel controls the data and all the views for an
2 Installation individual event log. Opening an event log creates a Master Control
8 : se“"&s‘;“e" to manage it. From the Master Control, you can create views into
2 oW the data, and move the current record in time. The Master Control is
= @ Data Views
shown here:

i\ data_0169b.er
Views  Bookmarks  TimeOffsst... Export..  Playback

®

Reports
Command Line Option:

Time: 329140505 | Bookmarks: [<none>

| %
2007-03:28 14.05.05.0 173353 20070330 10:42.44.

The Master Control allows you to:

Navigate in time

Navigate by record index

Bockmark a time in the event log, or move to a boockmark
Adjust the Time Offset for viewing

Export data

Create Views of the data

Playback the data

Override the calibration on allowed channels.
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4.11. Master Controller Time Navigation

il
Wigws  Bookmarks  Time Adjustment ...  Export...  Playback ... Help
Tirne: I-'I 208 17:30:2 ;I Bookmarks: |<n|:|ne> j _ﬂl
|« | <Da_l,l| < Hr | <h-1in| <Sec| Sec: | ki > | Hr > | Days | = |
2001208 1730:21.2 14103975 20171-02-07 18:12:00.3
] 2
Subrfile: |1 - 2M 01208 21:30:21.2 to 2011-02-07 22:12:00.3 j

ILLUSTRATION 45 — MASTER CONTROLLER NAVIGATION

The master controller handles are movement within the data through time.

e The user can use the Time Pull down menu to choose a time to jump to. All jumps will
appear in whatever views have been created.

e To quickly jump through time the user can use the slide bar at the bottom. Using the
mouse click on left or right arrow or grab the bar and slide to whatever time position is
needed.

« To jump to the beginning of the data file, click on ‘|<’ button.

« To jump to the end of the data file, click on *>|" button.

« Tojump back one day or forward one day click on the ‘<Day’ or ‘Day>’ buttons.

e Tojump back one hour or forward one hour click on the ‘<Hr’ or ‘Hr>’ buttons.

¢ Tojump back one minute or forward one minute click on the ‘<Min’ or ‘Min>’ buttons.

« Tojump back one second or forward one second click on the ‘<Sec’ or ‘Sec>’ buttons.

¢ Tojump between consecutive groups of records known as Sub-files.
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5. Information on software commands

The TraxSyte application can be started from the command line with some optional arguments.
These arguments control how TraxSyte starts up. The command line structure is shown below:

TraxSyte [<filename>.er|<filename>.tsws] {[-er:URI[#ERName]]}

Where:
e Items in [] are optional,
* Items separated by | are choices for an option,
e Items in {} can be repeated O or more times.

Here <filename> is the name of a file to load on start up. The the file extension is .er, and Event
Recorder log file is loaded. If the file extension is .tsws a TraxSyte workspace is loaded.

The -er switch is used to identify event recorders on the network that TraxSyte can access for
data downloads. The URI is the network address of the event recorder and ERName is an
optional name the user can use to identify the event recorder.

Note that you require an appropriate license to use TraxSyte for data downloads.

Examples:

[Command Line ||Result

TraxSyte MyWorkspace.tsws Starts TraxSyte and loads the
MyWorkspace.tsws workspace.

TraxSyte -er:10.0.0.1994#ER1 Starts TraxSyte and populates the Recorder
address dialog with the name ER1 which is an
event recorder at network address 10.0.0.199.

TraxSyte -er:10.0.0.199#ER1 - Starts TraxSyte and populates the Recorder

er:10.0.0.198#ER2 address dialog with the names ER1 and ER2 for
users to select.
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6. Error Messages and problem resolution

Errors in Event Log file. i 5]

3 Errors detected in C:\projects\935\SUM\Corrupted data\5 - Corrupted data in full record payload.er.

OK

ILLUSTRATION 46 — CORRUPTED DATA MESSAGE

« When the Data Analysis Software open the Event Recorder Data file, a integrity check is
done. If the check fails this message will appear.
*  Click 'Ok’ button to continue.

f 15 - Corrupted data in full re pra e s 54|
Wi Channels Export... Display Help
Time Speed ﬁ
2010-06-07 14-10-59 .8 35 5!
2010-06-07 14:10:59 9 29 9
Invalid: 5 Full records spannina 195 bvies
e T L B e B ] =S
o e = e T == 205
201 0-05-0F 191101 5 405
| 204 0-0S-0F e 20 =2t
e e B 434
20501 n.::_nﬁ _I'A:'E 1:n’)_4¢ 4_44
e = SR e S o =) s
e e e e e a e = g+ 5
20 0-065-8F 343103 0O = =
s e T 0 e TP e B - o 14!_:’1 1:”'3!_!2 5%8
7’)n1n U = i ‘!A:‘! 1:na_g 5_379
20350 O Vnﬁ _I'd:‘i 1:n'.§7'n, _55%
2O 0-0s-07F 11 30 3 555
209 0-0e-0F 314 33104 5 B e
e e O B e = =) S50
o = e e e e =A== o e
e e e L T == = ]
- I I bI

« Data will still be loaded into the Analysis software but where ever the errors are, a
strikethrough will be present with a message at the start of the bad block. The user can
either try to interpret this data or continue to the next valid data block.
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x

%y Tfyou print or export this report using more than 8 columns it may be difficutt to collate. Would you like to imit the
‘\'/ number of columns in the report to the first 8 visible?

Yes | No I

ILLUSTRATION 47 — PRINT SIZE WARNING

«  Printing more then 8 columns of data will cause multiple sheets to be printed as the data
spans horizontally. This message allows the user to only show 8 columns in the
generated report.

/| Log Loading Progress ] | LI;[QI.E‘J

i

File: Cprojects\935SUMWME 9103 4294967295 er
Size: 4542348

Records: 64858

Channels: 109

Unrecognized Channels: 0

Missing Records: 0

ILLUSTRATION 48 — DATA FILE LOADING PROGRESS

< During opening of a Event Recorder Data file, a loading progress window will appear.
The window gives specific details during the loading and closes when loading is
complete.
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x|

Unhandled exception hias occurred in your application.

@ If you click Continue, the application will ignore this
error and attempt to continue. If you click Quit, the
application will close immediately.

Could not find any resources appropriate for the
specified culture or the neutral culture. Make sure
"TraxSyte TraxSyte resources” was correctly
embedded or linked into assembly "TraxSyie" at

* Details I Continue | Cluit

ILLUSTRATION 49 — UNHANDLED EXCEPTION ERROR

« During normal operation of the Data Analysis Software, error conditions are normally
handled with options given to the user. If for any reason there is a software error that
does not have a handling condition, an Unhandled condition message box will appear.
The user can click on ‘Details’ to record the error, click on ‘Continue’ to see if the program
will bypass the error and continue or click on ‘Quit’ to exit the program.

« If this error occurs please restart the program and try again. Make a note of the
conditions that caused the error.
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7. Glossary

Term Description

DAS Data Analysis Software

ER Event Recorder

TraxSyte Name of Data Analysis Software
Exception Windows Error description

SUM Software User Manual

MDI Multiple Document Interface
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